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1 Sysmac Del 1 
 

1.1 Kodeforklaring i modellbetegnelsene 
 

Tabellen nedenfor viser hva tallene i Sysmac-CPUenes modellbetegnelse betyr.  

 

Øverste rad viser modellbetegnelsen for de 3 CPU-typene. X i de grønne feltene kan byttes ut med tall fra 0-9, 24 

eller 40 og T eller T1 for å endre på «egenskaper».  

 

 
Leser vi fra tabellen vil dermed NJ301-1120 utføre en instruksjon på 3ns, ha 5MB minne, Standard type, 4akse 

servo og med SQL-funksjonalitet.   

NJ501-1x00 har innebygd OPC UA Server. 

 

 
NX102 har innebygd OPC UA Server. 
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1.2 Minnetabell for CPU-typene 
 

 
NX1P2 bruker vi på små og mellomstore anlegg der pris er viktigere enn hastighet og 

kommunikasjon. 

 

NX102 er den generelle CPUen som kan brukes på små og mellomstore anlegg der det ikke er 

behov for CAN/Profibus/Profinet/Devicenet. 

 

NJ1/3/5 støtter ny (NX) og gammel (CJ) hardware så den er nok den mest fleksible 

 

NX7 er råtassen for ekstreme hastigheter og svært store program 

 

NY5 er kompaktløsningen med Controller og PC og evt. monitor i samme enhet. 

 

1.3 Firmware 
 

De aller fleste CPUer kan oppdateres med nyere Firmware. Firmware inneholder nye funksjoner og bug-fix. 

Oppdatering gjøres med SD-kort som du kan bestille ved å sende oss et bilde av etiketten på sida av CPUen slik at vi 

kan tilby deg beste løsning. Alle CPUer støtter Version som er lik eller eldre enn den Firmware som er installert. Se  

utklippet fra Sysmac Studio under her: 

 

 
 

Du må som regel ha siste versjon av Sysmac Studio for å kunne kommunisere med CPUer med nyeste Firmware. 

 

Fra Sysmac Studio 1.50 foregår nå all kommunikasjon med CPUene via kryptert protokoll. Hvis din CPU er eldre 

enn Firmware 1.49 (som støtter denne protokollen) må kommunikasjonen foregå ukryptert. Dette gjøres automatisk 

ved valg av rett Firmware på CPUen i Sysmac Studio. 
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1.4 Omron kurstrainer 
 

 
 

Traineren består av:  

 

NX102 CPU 

W4S1 Ethernetswitch for CPU, panel og PC 

S8VK powersupply, 

S8VK-X powersupply med Ethernet/IP  

NX-ECC-rack med Safety og I/O. Racket er koblet opp til CPUen på EtherCAT-bus. 

NA operatørpanel som kommuniserer med CPUen over Ethernet/IP. 

4 vribrytere med innebygget lampe. Alt er ferdig koblet inn på IO-modulene. 
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1.5 Sysmac Studio 
 

Dette programmet brukes til programutvikling på Sysmac-serien CPUer. Dette er modellene NX7, NJ, NX102 og 

NX1P2. Med SysmacStudio kan man også lage applikasjoner på Sysmac NA operatørpanel og konfigurere og 

programmere NXSafety. 

 

Sysmac Studio Full-lisens, for alle N-CPUer 

Sysmac Studio Lite-lisens, samme som Full-lisens, men ikke for NJ3, NJ5 og NX7. 

 

Begge har funksjoner for:  

Oppbygging av Funksjonsblokkbibliotek for CPUer. (Library). 

Oppbygging av grafiske animerte objekt for NA. (IAG) 

Konfigurering av FH og FQM visionsystem 

Konfigurering av ZW-målesensor 

Parametrering av G5 og 1S servosystem 

Parametrering av MX2 og RX frekvensomformere 

Konfigurering av NX-remote IO 

TeamDevelopment for flerbrukerutvikling av same prosjekt (Tilleggslisens) 

Versjonskontroll for lagring og sammenlikning av eldre prosjektversjoner (Sammen med TeamDevelopment) 

 

For C-serien PLSer som CJ, CS,CP, osv. må man bruke CxProgrammer. Altså CPUer som begynner med C. 

Operatørpaneler av type NS, NT, NB, NQ støttes heller ikke. 

Det er ikke mulig å konvertere PLS-programmer eller skjerm-applikasjoner fra disse til Sysmac Studio. 

 

Sørg alltid for å ha siste versjon av SysmacStudio på PCn din. I windowsmenyen finner du et eget program for 

oppdatering av programmet. Oppgradering vil ofte være gratis. 

 

 
 

For å kunne oppdatere må du på forhånd ha registrert mailadresse og lisenskode på internett. 

https://industrial.omron.no/no/services-support/technical-tools/software-registration-downloads 
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1.6 Tilkobling til en helt ny CPU 
 

CPUer med Firmware 1.49 eller nyere har fått en funksjon for å unngå uautorisert tilgang til CPUen. Man kan legge 

inn et brukernavn og passord som man må ha for å kunne kommunisere med CPUen. I tillegg er all kommunikasjon 

med NA operatørpanel og Sysmac Studio kryptert. Dette er spesielt viktig hvis man sender data over ubeskyttede 

linjer. F.eks. internett. Du kan slå av krypteringen ved å sette DIPSW#1=ON og DIPSW#2=ON. 

 

Ved første gangs tilkobling vil man etter å ha lagt inn navn på Controlleren, få opp følgende bilde i Sysmac Studio: 

 

Hensikten er å unngå at uautoriserte får tilgang til CPUen. Legg inn 

ditt brukernavn og ønsket passord som Administrator. Hvis du ikke 

ser noen hensikt i å beskytte CPUen, kan du deretter velge bort 

Enable nede til venstre. Da har alle tilgang til CPUen uten pålogging. 

(Ditt brukernavn blir da lagret i en logg for å registrerer hvem som 

som tok vekk Enable) 

 

Hvis du velger vekk denne funksjonen nå, kan du aktivere den senere 

under Controller->Security... 

 

(TCP port 80 unsecure er byttet med TCP port 443 secure) 

 

1.7 Jeg har glemt brukernavn/passord 

Sett DIPSW#4=ON. Slå på strømmen på CPUen og følgende bilde kommer opp når du prøver å gå online: 

 

Aktiver Agree, og trykk OK for å slette alt i CPUen slik at du kan begynne på nytt med en tom CPU. 
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1.8 Opprette et nytt prosjekt Online  
 

1.8.1 Direct Ethernet Connection 
 

Bruk av Direct Connection forutsetter at din Windows tillater at følgende program får kjøre fritt mot Ethernetporten. 

 

 
 

 

Velg riktig nettverkskort i PCen som er koblet mot CPUen. 

 

 
 

Trykk Confirm……….. nederst på skjermen. 

 

Velg Direct…… som det står i bildet under, trykk Browse og sjekk at du har kontakt med CPUen. 

 

 
 
Kjør gjerne en test for å sjekke at dette fungerer som det skal. Hvis ikke, må du endre IP-adressen i PCen slik at det 

passer med PLSens Subnett. 

mailto:support.norway@omron.com


 
Postadresse:  Besøksadresse:  Telefon:   22 65 75 00  Foretaksregisteret: 

Postboks 109, Bryn Ole Deviks vei 6B Support:   23 17 39 40  NO 852 345 632 MVA 

N-0611 Oslo  0611 OSLO       

support.norway@omron.com   15/194 

 

1.8.2 Direct Ethernet med NX102 og NX1P2 
 

Koble en Ethernetkabel mellom PCen og CPUen. Du trenger normalt ikke å tenke på å endre IP-adresse eller bruke 

en krysset kabel. Velg Connect to Device. Sørg for at Direct connection via Ethernet er valgt og ta bort «Upload 

the project» 

 

 
  

 

Yes =kopiere navnet på Controller inn i 

Prosjektet på PCen. 

 

Ta en vurdering på om det er dette du vil. 

 

 

 

 

 

 

 

For å kunne endre på navnet i CPUen, må du først gå Offline og velge nytt navn via høyreklikk på ikonet. 

 

 
 

Deretter gå Online igjen, og nå trykker du No-knappen. 

Til slutt velger du  «Controller» i hovedmenyen og «Update CPU Unit Name» 
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1.8.3 USB med NJ 
 

Sett i USB-kabelen og velg Connect to Device. Se at USB er valgt i menyen og ta bort «Upload the project» 

 

 
 

 

  

 

Yes =kopiere navnet på PLS inn i Prosjektet. 

 

 

Ta en vurdering på om det er dette du vil. 

 

 

 

 

 

 

For å kunne endre på navnet i CPUen, må du først gå Offline og velge nytt navn via høyreklikk på ikonet. 

 

 
 

Deretter gå Online igjen, og nå trykker du No-knappen. 

Til slutt velger du  «Controller» i hovedmenyen og «Update CPU Unit Name» 
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1.9 Smarte innstillinger før du begynner 
 

Under «Tools/Option…» kan du stille inn dine ønsker for SysmacStudio.  

 

Det første du bør gjøre er å stille «Variables» slik at alle endringer i symbolnavn også blir endret i programmet. 

 
 

På ColorTheme kan du velge hvit på grå bakgrunn eller omvendt. 

 
 

Under «LadderEditor» er det mye å velge i, men gjør deg litt kjent med disse innstillingene. 

 

Under «Comments for Variables and Data types» kan du velge mellom visning av Comment1 og Comment2. På den 

måten kan du legge inn kommentarer på to språk i programmet. 

 
 

Hvis du vil benytte Excel til å oversette fra Comment1 til Comment2, kan du eksportere kommentarene dine med 

«Tools/Comments for Varables and Data Types/Export…». Da vil du generere en redigerbar .csv-fil som du senere 

kan importere. 
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1.10 Menyene i Sysmac Studio 
 

 
 

Prosjektfilene dine ligger i mappa: C:\OMRON\Data\Solution, men du kan ikke identifisere hvert enkelt prosjekt. 

Du bør ta jevnlig backup av denne mappa, eller eksportere prosjektene dine til en sikker plass.  

New Project bruker du for å starte et prosjekt fra bunnen av. Her 

kan du ha flere CPUer og HMI hvis du ønsker det. 

 

Open Project bruker du for å jobbe videre på et prosjekt du har 

lagret lokalt på PCen 

Import bruker du for å åpne en *.smc2-fil. Dette er en slags zip-fil 

hvor prosjektet ditt er pakket sammen. Smc2-filer er praktiske å 

bruke når man ønsker en backup av prosjektet.  

Export bruker du til å lage *.smc2-fil av prosjektet som du har 

lokalt på PCen 

Connect to Device bruker du når du vil koble deg til en CPU/HMI 

og laste inn prosjektet til PCen. Typisk når du ikke har en kopi 

lokalt selv. 

Version Control Explorer brukes til versjonskontroll og 

teamutvikling hvor flere kan jobbe mot samme prosjekt. Alt ved 

hjelp av GIT og verktøyet Tortoise. Denne funksjonen krever 

egen lisenskode. 

License brukes til å legge inn lisenskoden for Sysmac Studio og 

tilleggslisenser du har kjøpt. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Open in Emulation mode brukes bare ved programmering av 

Robotcontrollere. 
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Project name er en tekst for å identifisere prosjektet ditt på 

prosjektlista når du velger Open Project. 

Author er navnet ditt 

Comment er en beskrivende tekst for prosjektet  

Type definerer hva slags prosjekt du ønsker å lage 

-Standard, prosjekt med Controllere og eller HMI, Safety, IO, 

omformere, servo, vision osv. 

-Library, funksjonsblokkbibliotek som kompileres til *.slr 

-IAG, grafiske animerte objekter for HMI som kompileres til *.iag 

Category, hva du ønsker å programmere/konfigurere. Velger du 

Controller kan du legge til noen av de andre i prosjektet etterpå. 

Device, Modellbetegnelse 

Version, Firmwareversjon på komponenten du har valgt. Denne 

kan du endre på senere hvis du er usikker. 

Close lukker prosjektet og åpne et annet/nytt. 

Save lagrer prosjektet 

Save As lagrer prosjektet med et nytt navn 

Save As New Number lagrer prosjektet som en nummerert 

versjon av originalprogrammet. 

Import bruker du for å åpne en *.smc2-fil. Dette er en slags zip-fil 

hvor prosjektet ditt er pakket sammen. Smc2-filer er praktiske å 

bruke når man ønsker en backup av prosjektet. 

Export bruker du til å lage *.smc2-fil av prosjektet som du har 

lokalt på PCen 

Offline Comparison, her kan du sammenlikne prosjektet ditt med 

et annet prosjekt for å få opp forskjellene. 

Page Setting, oppsett for å skrive ut prosjektet 

Print skriver ut prosjektet 

Exit avslutter Sysmac Studio 
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Multiview Explorer, Prosjekttreet 

Project Shortcut View, her kan du lage deg en hurtigvalgmeny når 

prosjektet begynner å bli veldig stort 

Toolbox, verktøykassa som vanligvis står i høyremargen 

3D Visualizer, et robotvindu for å se roboten i 3D når du jobber 

med programmering av robot. Finnes også som knapp 

Output Tab Page, vindu for statusmeldinger. Finnes også som 

knapp. 

Watch Tab Page, vindu for å monitorere varabler. Finnes også 

som knapp. 

Watch Tab Page (Table), vindu for å monitorere variabler i 

tabellform. Finnes også som knapp. 

Cross Reference Tab Page. Kryssreferansevindu for å se hvor 

variabler er benyttet i programmet. Finnes også som knapp. 

Build Tab Page, statusvindu for programkompilering. Finnes også 

som knapp. 

Search and Replace Result Tab Page viser vinduet som inneholder 

resultatet av siste Search&Replace 

Simulation Pane viser vinduet som brukes av Simulatoren 

Differential Monitor brukes for å telle flanker på boolske 

variabler. Finnes også som knapp. 

Programming Group Tab Page 

Variable Table åpner vinduet med lokale og globale variabler. 

Samme som den hvite trekanten i hjørnet. 

Variable Manager gir deg muligheten til å få en liste over alle 

variabler, hvor mange forekomster osv. Man kan også slette 

ubrukte variabler her. 

Smart Project Search, her kan du søke etter alle mulige tekster i 

Sysmac Studio 

Recently Closed Windows husker vinduer du har lukket 

Clear Recently Closed Windows History 

Zoom har 4 undervalg for zooming inn/ut slik at det blir lettere å 

se tekst eller få oversikt. Finnes også som knapper. 

Manage Window Layout Templates, lar deg lagre flere Layouts 

for vinduer 

Reset Window Layout, flytter alle vinduer slik de sto opprinnelig 
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Circuit Parts, basic ladderfunksjoner som også finnes i Toolbox 

og som hurtigtaster 

Derive Device, deling av ressurser/programmer mellom flere 

CPUer for å unngå mye copy&paste og manuell oppdatering 

Controller, samme som Add Device for å legge til flere CPUer 

Application Manager, legge til et robotprosjekt tilsvarende ACE 

Safety Network Controller, legge til en Safetycontroller i 

prosjektet 

Drive, legge til en eller flere EtherCAT servodrives som en 

separat enhet uavhengig av en Controller 

HMI, samme som Add Device for å legge til flere NA HMI 

Measurment Sensor, koble til eller legge til en ZW målesensor i 

prosjektfila 

Vision Sensor, legge til et FH-system i prosjektfila 

Slave terminal, legge til en NX-EIC eller NX-PNC som separate 

enheter i prosjektfila 

Program, legge til et nytt Program eller Section 

Function, legge til en ny Function 

Function Block, legge til en ny FunctionBlock 

Axis Settings, legge tile en ny Axis (f.eks. servo) 

Axes Group Settings, lage en ny aksegruppe (gruppestyring) 

CNC Settings, innstillinger for Controller med CNC-funksjoner 

Robot Control Setup, innstillinger for Controller med 

Robotfunksjoner 

Cam Data Settings, legge til en CAMprofil for servokjøring 

Data Trace, Legge til en DataTrace for logging 

DB Connection Settings, legge til en Databasetilknytning for 

Controller med databasefunksjoner 

Check All Programs vil finne feil i alle programmene dine 

Check Selected Programs vil finne feil i valgt program 

Build Controller, kompilerer programmet og viser eventuelle feil 

som ikke lar seg kompilere 

Rebuild Controller, er en komplett gjenoppbygging av 

programmet og tar litt lengre tid enn en Build 

Abort Build avbryter kompileringen 

Memory Usage, her kan du se hvor mye minne du har brukt av 

total kapasitet 

Online Edit, her kan du velge å editere programmet ditt direkte på 

Controlleren uten å måtte overføre til eller stoppe CPUen. 

Library, her kan du ta inn Libraryfiler i prosjektet ditt. Hvis du har 

valgt å lage et Library, er det her du gjør nødvendige innstillinger 

og kompilerer til et ferdig *.slr. 
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Security>

Communication Setup, her velger du hvordan du tenker å koble 

deg til utstyret 

Change Device, her kan du bytte til en annen CPU, HMI eller 

Firmware. Programmet tilpasser seg CPUen du velger. 

Online bruker du for å koble deg til Controlleren. Finnes også 

som knapp. 

Offline bruker du for å koble deg fra Controlleren. Finnes også 

som knapp. 

Synchronize åpner synkroniseringsvinduet for å kunne overføre 

program til/fra controlleren. 

Transfer for å overføre prosjektet til eller fra Controlleren 

Mode, velge om programmet skal kjøre eller ikke i CPUen. 

Finnes også som knapper. 

Monitor for å lese status på variabler 

Stop Monitoring for å avslutte lesing av status på variabler 

Set/Reset kan du velge på en kontakt for å endre mellom AV/På 

så lenge den ikke er påvirket av andre signaler 

Forced Refreshing, her kan du tvinge innganger og utganger til en 

valgt status for å teste resultatet. 

MC Test Run kan du bruke til å testkjøre en servoakse 

MC Monitor Table viser status på signalene på en servoakse 

CNC Coordinate System Monitor Table, vise koordinatsystemene 

til en CNC-Controller 

SD Memory Card er en “Utforsker» for minnekortet du har satt 

inn i CPUen 

Controller Clock for å endre eller synkronisere klokka i CPUen 

Release Access Rights åpner opp fil-låsing som kan ha oppstått 

ved strømbrudd eller kommunikasjonsfeil. En funksjon som 

brukes svært sjelden. 

Update CPU Unit Name for å endre navnet på CPUen til det 

navnet du har satt i Sysmac Studio 

Security, se neste avsnitt for detaljer 

Clear All Memory vil tømme CPUen for alle data og program 

Reset Controller kan du bruke for å reboote Controlleren, akkurat 

som å slå strømmen av/på. 

Set Up User Account 

Show user account list 

Change password 

Setting of Operation Authority bestemmer hvem som har tilgang 

til å gjøre endringer i programmet. Flere passordnivå kan lages. 

ID for User Program Execution, passord for å unngå at 

programmet kan kjøres på en annen CPU 

CPU Unit Write Protection gjør at du ikke kan overskrive CPUen 

med et nytt program 

Set/Release Data Protection, aktiverer/deaktiverer 

lese/skrivebeskyttelse for flere type data i CPUen 

Temporary Release of Change Prohibition gir deg midlertidig 

tilgang ved riktig angitt passord 

Finish Temporary Release of Change Prohibition opphever 

foregående funksjon 

Temporary Release of Display/Change Prohibition gir deg 

midlertidig tilgang på Display/Endre ved riktig passord 

Finish  Temporary Release of Display/Change Prohibition 

opphever foregående funksjon 

Secure Socket Setting er for de som ønsker å opprette kryptert 

kommunikasjon over Ethernet 
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Run kjører programmet i Simulatoren 

Run in PROGRAM mode starter Simulatoren uten å kjøre 

programmet 

Pause, sette programmet i pause 

Stop, stoppe kjøring av programmet 

Step Execution, kjøre programmet linje for linje for lettere å 

kunne se hva som skjer 

Step In brukes for å kjøre stegvis igjennom en F eller FB 

Step Out brukes for å gå ut av ovenstående kjøring 

Continuous Step Execution kjører igjennom programmet med 

valgt hastighet 

Execute One Scan kjører igjennom programmet bare en gang 

Jump to Current Position flytter markøren til det punktet i 

programmet som kjøringen har stoppet 

Breakpoint Window for å velge tillegssfunksjoner for Breakpoints 

Set/Clear Breakpoint for å sette et punkt i programmet hvor 

simulatoren skal stoppe 

Enable/Disable Breakpoint, beholde posisjonen med koble dem 

inn/ut midlertidig 

Calibration kjører en testrutine for å kalibrere PCen slik at den 

kan simulere en controller og syklustiden på best mulig måte 

Run in Execution Time Estimation Mode for å stipulere 

controllerens syklustid med simulert program 

Transfer All Variable Present Values for å skrive eller lese 

variabler som er lagret tidligere for å unngå å legge dem inn 

manuelt ved hver simulering 

Run with NA Simulator for å simulere NA-prosjektet sammen 

med simulatoren for Controlleren 

Start NS Integrated Simulation kobler Simulatoren til et NS-

prosjekt laget i CX-Designer 
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Troubleshooting åpner vinduet for feilmeldinger og hendelser. 

Finnes også som knapp 

Event Log Viewer brukes til å åpne EventLog-filer som du har 

lagret unna på disken din 

EtherCAT Diagnosis/Statistics Information Viewer brukes til å 

åpne EtherCAT Diagnosis-filer som du har lagret unna på disken 

din 

Backup brukes til backup og Restore av programmer og varabler. 

Ei Backupfil kan ikke åpnes i Sysmac Studio. 

Export Global Variables brukes for å eksportere variabler merket 

Input/Output eller Publish til fil, så du kan importere i 

CX_Configurator og CX-Designer/MoviconNEXT 

Comments for Variables and data Types (For switching) brukes 

for eksport/import av variabelkommentarer. Typisk hvis du har 

valgt 2-språk i option-menyen. 

Import ST Program laget for SysmacStudio i Simulink PLC Coder 

IEC 61131-10 XML for å importere programmer som er laget i 

henhold til IEC61131-10 

IEC 62714 AutomationMLfor å importere komponenter og IO-

Lister fra ePlan Electric 

Import Motor sizing tool Results, bruker du når du har satt opp 

servosystemet ditt i programmet MotorSizingTool og ønsker å 

slippe å taste inn alt på nytt i SysmacStudio 

SYSMAC Gateway for å eksportere «User Event Definition File» 

Update Configurations and Setup Transfer Data velger du hvis du 

må oppdatere Controlleren med data fra en ny EtherCAT ESI-fil 

Ethernet/IP Connection Settings brukes til å konfigurere 

datautveksling med andre enheter via Ethernet/IP  

Launch External Application brukes for Controllere med CNC-

funksjoner 

Customize Shortcut Keys brukes til å lage sine egne hurtigtaster 

for systemet 

Option, her velger du dine egne preferanser for Sysmac Studio 
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1.11 Oppsett av lokale I/O for NJ og NX 
 

NJ- og NX-serien er bygd opp forskjellig. NJ benytter I/O fra CJ-serien. NX1P2 har faste lokale I/O hvor man i 

tillegg kan bygge ut med NX-I/O. For NX102 må man sette på NX-I/O etter behov.  

 

Gå Online med CPUen for å sette opp I/O automatisk. 

Ved å dobbeltklikke på CPU Rack får man opp et bilde som viser konfigurasjonen som er lagret i prosjektet. Har 

man satt inn flere enheter i racket, høyreklikker man på CPUen i bildet og velger Compare and Merge som vist 

under. Alle nye moduler og I/O vil du nå finne under I/O Map. Gå offline for å jobbe videre med prosjektet. 
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1.12 Oppsett av RemoteIO for NJ og NX 
 

Sørg for at du fortsatt er Online med CPUen. Velg EtherCAT for å åpne nettverksbildet. 

 

 

 

 

 

 

 

 

 

 

 

Høyreklikk på Master-ikonet og velg «Compare and Merge….» 

 

 
 

Nå vil nettverket leses inn og du vil kunne se alle nodene som er tilgjengelig på EtherCAT.. 

 

OBS! Ein må 

vere «online». 
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Trykk «Apply actual…» for å overføre dette til prosjektet ditt. Når begge vinduene er like, velger du «Close». 

Gå «Offline» for å jobbe videre med prosjektet. 

1.13 Oppsett av «Machine Controller» 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Dobbel-

klikk 

Her kan du legge 

inn «Routing table» 

for FINS komm. 

(Du Slepp å bruke 

CX-Integrator) 
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1.14 Tilordne symbolske navn på Local og Remote I/O 
 

Velg I/O Map i menyen 

 
 

Deretter høyreklikker du på firkanten anvist nedenfor og velger «Collapse all» for å få mer oversikt i lista. 

 
 

Deretter åpner du linja med NX-ECC201 for Remote I/O og inngangsmodulen slik som vist på bildet. 

For Lokale IO følger du stort sett samme prinsipp, men der vil ikke I/O ligge under NX-ECC201 men under 

Built-in I/O Settings eller NX Bus Master 

  

 
 

Hvis du nå høyreklikker på NX-ID4442 kan du autogenerere symbolske navn på alle 8 inngangene samtidig. Det er 

disse navnene du skal bruke når du programmerer. 
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Du står nå helt fritt til å editere navnene til noe mer forståelig. 

Alle disse symbolske navnene finner du nå i lista over «Global Variables» 

 

 
 

Gjenta dette for det digitale utgangskortet og kall den ene utgangen for DO_Valve_1. 

 

 

 

For Lokale IO følger du stort sett samme prinsipp, men der vil ikke I/O ligge under NX-ECC201 men under 

Built-in I/O Settings eller NX Bus Master 
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1.15 Globale variablar 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Variabler kan ha flere egenskaper. Vi ser litt på variantene nedenfor: 

 

 
 

• VarNormal går alltid tilbake til InitialValue når du stopper programmet men den kan 

endres underveis under programkjøring. 

• VarRetain settes til InitialValue når du overfører programmet, deretter beholder den sin 

nye verdi ved en eventuell endring under kjøring og programstopp 

• VarConstant kan ikke overskrives, ReadOnly, og beholder alltid sin verdi 

• VarRetainConstant er også ReadOnly og beholder alltid sin verdi 

 

1.15.1 OPPGAVE: Editering av Symboler i Excel 
 

Kopier lista inn i Excel og bytt ut alle Input_Bit_ med Bryter_ 

Lim lista tilbake til Global Variables. 

 

  

Knytning til hardware 

har eit virtuelt CJ 

minne også 
Med «batteri» 

minne 

 

Interne variablar, vert automatisk tildelt 

ein minneplass i «controlleren» 
Se kapittel om Ethernet/IP for 

beskrivelse av Network Publish 
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1.16 Kommunikasjonsinstillinger Ethernet/IP og FINS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Det er ikke så vanlig å bruke FINS for kommunikasjon lenger, men detaljer om oppsett av Routing Table og FINS 

finner du i kapitlet om FINS. 

 

NX102 har 2 ethernetporter. Vi bruker vanligvis den øverste porten til programmering. 

 

 
 

  

Dobbel-

klikk 

Default 

IP-adresse 

På same måte  

som i CJ 

Vil gjenskape 

IP-adresse basert 

på node nr. 
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1.17 Lag eit lite program 
 

Et nytt prosjekt inneholder alltid en tom Rung. Den røde streken viser at det ikke er tillatt å overføre denne til 

CPUen. Vi må derfor alltid lage et program i denne Rungen. 

 

 
 

 

Vi lager oss no eit liten «ladder» kode. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Sett inn ein utgang for N7_DO_Valve_1: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Holder du pekeren over et symbolsk navn vil du se meir informasjon:    

Dobbel-

klikk 

Skriv inn 

«Test_Bit» 

Markèr og 

trykk «c» på 

tastaturet 

Vert automatisk 

lagd inn som intern 

variabel 

Markèr og 

trykk «o» på 

tastaturet 
Begynn å 

skrive «N» 

Vel 

utgangen. 
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1.17.1 Kompilere programmet og sjekke for feil. 
 

Før vi synkroniserer med «Machine Controller», er det en fordel å kompilere programmet. 

Når ein kompilerer programmet, vil det også verte utført ein programsjekk. 

 

 

 

 

 

 

 

 

 

1.17.2 «online» via USB 
 

Vi kan gå «online»  via USB hvis vi har en NJ 

 

 

 

 

 

 

 

 

 

 

 

 

1.17.3 «online» via Ethernet 
 

Vi må bruke Ethernet for å gå «online»  med NX 

 

 
 

1.17.4 Gå «online»  
 

Bruk knappen med den gule trekanten for å gå online med CPUen. 

 

 

 

 

 

 

 

 

 

 

 

 

For å sette «Machine Controller» i RUN, trykker du her: 

 

 

0 errors ☺ 

Kan velje å skjule/vise 

warnings/errors 

Når du er «online» får 

du status nede til høgre 
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1.17.5 Synkronisere prosjektet med «Machine Controller» 
 

Synkronisering betyr at du ønsker å få samme program i PCen som i CPUen. Enten ved å skrive prosjektet ned i 

CPUen eller å lese programmet opp fra CPUen. 

 

«Clear the present values»: Nullstiller alle variabler i minnet. Normalt gjør vi ikke dette 

 

«Do not transfer the program source»: Programmet kan ikke leses FRA CPUen etterpå. 

Normalt velger vi å overføre kildekoden 

 

«Do not transfer the following» : Ikke overfør parameterData fra/til lokale spesialkort (analogkort, SCU osv) og 

parametre fra/til enheter på EtherCAT (omformere, servodrive osv) 

Hvis du har gjort dette en gang, trenger du ikke å gjøre det flere ganger. Det er viktig å ta med disse når du skal ta 

Backup eller utføre en komplett oppdatering. DETTE KAN TA FLERE MINUTTER. 

 

«Do not transfer the Ethernet/IP”: Ikke overfør konfigureringsdata for datautveksling via EthernetIP  

Vanligvis gjør du dette via EthernetIP-konfiguratoren slik at det er unødvendig å velge det her. Typisk vil du ta med 

dette når du skal laste samtlige data fra CPUen. 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.17.6 Informasjon om Controlleren 
 

Ved å trykke på den lille pila i bildet til høyre vil du få opp informasjonsbildet som vist til venstre. Her er det mye 

informasjon som kan være nyttig. 

 

  

OBS! Ein må 

vere «online». 
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1.18 Bruke I/O «Map» til å «ringe ut» I/O 
 

I I/O Map kan du teste utgangene dine. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Dobbel-

klikk 

Høgre-

klikk 

Sjekk LED 1 på 

utgangsmodul 
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1.19 Bruke «Watch Window» til å teste programmet 
 

I Watch Window kan du monitorere alle variablene i prosjektet. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For å velje Test_Bit, må vi søke etter Program0.Test_Bit: (Test_Bit er nemlig en intern variabel i Program0) 

 

 

 

 

 

 

 

 

 

 

 
 

Eller du kan dobbeltklikke på kontakten for å få opp knappene direkte.  

 

 

Her kan du bruke «true» og «false» 

knappene 

Skriv «P» pass på at Program0 

er lyseblå, og trykk «.» 
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1.20 Kryssreferanse 
 

 
I Cross Reference kan du lokalisere symboler i programmet på en enkel og oversiktlig måte. 

 

  
 

Oversikten viser antall forekomster, den viser hvilken forekomst markøren står på samt hvordan denne er brukt i 

programmet. Du kan klikke i vinduet nederst for å hoppe i programmet, eller du kan klikke i programmet for å 

oppdatere lista i vinduet nederst. 

Cross Reference vil også henvise til NA-prosjektet ditt, slik at du kan se om objektet er brukt der. 
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1.21 Laddereditoren 
 

Kontakt- og utgangssymbolet kan ha mange varianter. Bildet under viser disse. Du kan bruke hurtigtaster, menyvalg 

eller høyre mustast for å få tilgang til disse symbolene. 

 

 
 

Funksjoner og Funksjonsblokker finner du i Toolbox-menyen til høyre i Sysmac Studio. Disse kan både settes etter 

hverandre eller over hverandre som OG- og ELLER-kretser. Alle Funksjonsblokker må ha et eget navn for at det 

skal kunne reserveres egne dataminner til disse internt. Funksjoner har ikke det. 

 

Inngangen på funksjoner og funksjonsblokker kan inverteres med høyre mustast. Du velger da «Toggle Negate» og 

dette blir vist som en liten sirkel på inngangspinnen på blokka. 

 
 

 

På endel matematikk- og sammenlikningsblokker kan du legge til flere pinner for å forenkle programmeringen. 

Dette gjør du med valget «Add input» på høyre mustast når du har valgt blokka. 

 
 

Hvis du setter @ foran navnet på blokka vil den bare bli utført på stigende flanke på EN. Altså bare ett programscan. 

Dette gjelder bare for såkalte Functions, men heller ikke alle. Se manualen eller bruk Help-menyen.  

 

 

  

mailto:support.norway@omron.com


 
Postadresse:  Besøksadresse:  Telefon:   22 65 75 00  Foretaksregisteret: 

Postboks 109, Bryn Ole Deviks vei 6B Support:   23 17 39 40  NO 852 345 632 MVA 

N-0611 Oslo  0611 OSLO       

support.norway@omron.com   39/194 

 

1.21.1 Timere 
 

En forsinket-inn-timer ser slik ut: 

 
 

Tiden PT angis i timer, minutter, sekunder eller millisekunder eller kombinasjon av disse. ET viser hvor lang tid 

som har gått og Q går på når tiden PT har gått ut. Alle TON timere må ha et navn slik at en kan referere til Q eller 

ET senere i programmet. Legg merke til at PT har den spesielle Datatypen TIME som er en tidsangivelse og ikke en 

tallverdi. Husk å ta med hash-symbolet når du setter datatypen foran en konstant. 

 

 
 

Noen ganger regner vi ut tiden eller vi setter den som en tallverdi i et operatørpanel. Vi må da som regel konvertere 

til TIME for å kunne bruke den som en tid på en Timer.  

 

Trikset er å bruke NanoSecToTime(Tidverdi*1E9) hvis Tidverdi er angitt i sekunder. 
(Vi må huske å gange sekunder med 1*10^9 for å få nanosekunder) 
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1.21.2 Compare 
 

Sammenlikningsfunksjonene bruker vi til å se på tall, tid, dato eller tekst i forhold til hverandre. Det finnes mange 

funksjoner for dette med typisk bruker vi = , > og <. Pass på så du bruker samme datatype på variablene dine og sett 

gjerne datatypen foran konstanter. 

 
 

Slik kan vi sjekke et tidspunkt med datatype TIME_OF_DAY (TOD).

 
 

Vær forsiktig ved bruk av = for REAL/LREAL. Avrundingsregler kan gjøre at betingelsen aldri blir oppfylt. 

100.00000001 er ikke det samme som 100.0. 

 
 

Se eksempel under: 

 
 

B er FALSE selv om A er 1.6.  

F er 1 når A divideres på 1.6. 

E viser differansen mellom A og 1.6. =(0.000000023841858) 

 

Unngå konstanter når du skal gjøre sammenlikninger og matematikk med flyttall: 
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1.21.3 Klokkepulser 
 

Funksjonen Get1sClk gir utgang i 500ms hvert sekund.  

 

 
 

Det finnes 7 forskjellige tider å velge imellom. En enkel måte å finne disse på er å søke på «get» i Toolboxen. 

 

 
 

 

1.21.4 OPPGAVE: Lag et program for å styre en pumpe 
 

Pumpa blir vanligvis kjørt av en frekvensomformer, og da har vi følgende signaler: 

 

 

Forslag til Innganger: 

Kjører 

Feil 

HastighetOppnådd 

 

Forslag til utganger: 

Start 

ResettFeil 

LavHastighet 

HøyHastighet 

 

Når pumpa har gått i 10sekunder skal den skifte fra høy til lav hastighet. 

 

Legg merke til at vi ikke har Stoppsignal, så pumpa vil stoppe når Start forsvinner. 

Ved Feil må Start gå av. 

Feil vil ikke forsvinne før ResetFeil har gått på. 
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1.22 «Event Settings» 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

En kan lage 5120 egendefinerte feilmeldinger. Disse kan bli vist i SYSMAC Studio (Velg Tools->Troubleshooting 

når du er online) eller i feilmeldingsloggen på et NS-panel. Se W504/7-11-6. 

NA-panelet har også en slik Event-logg (se bilde under) som du f.eks. kan ta frem ved å trykke en knapp som 

aktiverer SystemTag «ShowTroubleshooter». 

Info1 og Info2 er tallkoder du kan sette inn som en ekstra referanse til feilmeldingen. Legg merke til at du kan ha 

flere språk på meldingene dine. 

 

 
 

 

1.22.1 OPPGAVE: Lag en Event som trigges når pumpa går i feil 
 

Bruk funksjonen som beskrevet ovenfor.  

Kan nytte denne FUN for å sette event 

aktiv. 

mailto:support.norway@omron.com


 
Postadresse:  Besøksadresse:  Telefon:   22 65 75 00  Foretaksregisteret: 

Postboks 109, Bryn Ole Deviks vei 6B Support:   23 17 39 40  NO 852 345 632 MVA 

N-0611 Oslo  0611 OSLO       

support.norway@omron.com   43/194 

 

1.23 Program 
 

Eit program må knyttast til ein task for å verte utført. Program kan kalle opp funksjonar og funksjonsblokker. 

Til forskjell frå CJ serien, har program ikkje direkte aksess til globale variablar. 

Dersom ein nyttar ein global variabel i eit program, vil den automatisk verte lagd til i «Externals» i variabellista. 

Programmer kan deles inn i Sections for å få bedre oversikt. Dette har ingen betydning for programkjøringen. 

 

 
 

1.24 «Task Settings» 
 

Arbeidsoppgavene til NJ kan deles inn i flere Tasks. PrimaryTask er en prioritert task over alle andre. Syklustiden 

kan velges fra 0.5-4ms. En kan velge å få alarm hvis NJ ikke klarer å kjøre ferdig innen en viss tid. PrimaryTask 

brukes typisk ved servostyring, men den kan også brukes hvis en ikke lager altfor store program. 

 

 
 

Et PLS-program hvor millisekunder ikke betyr så mye, bør kjøres i en PeriodiskTask. Korteste syklustid på en 

periodisk task er 10ms. Legg gjerne inn denne før du begynner. 

 

 
 

Bildet viser PrimaryTask som inneholder Program0 og PeriodicTask0 som har fått Program1. Trestrukturen 

nedenfor vil vise det samme. Husk at alle programmer du lager må tilordnes en Task. Hvis ikke blir de aldri kjørt. 
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1.24.1 Priority 4 Primary Periodic Task 
 

 

 

 

 

 

 

 

 

 

 

En Task kan vi velge å kjøre direkte etter oppstart 

 
eller via kommando i programmet: 

 

 
 

1.24.2 OPPGAVE: Test av ActEventTask  
 

Lag et enkelt program i Program1 og start/stopp dette med Funksjonen ovenfor. 

  

Task period 

Task period 

Primary 

Periodic task 

Periodic task 

Execution priority 
16 

Task period Task period 

Standby 
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1.25 POU (Program / Funksjonsblokker / Funksjonar) 
 

POU (Program Organization Units) innbefatter program, funksjonsblokker og funksjonar. Etc 

Dette er softwaremodellen spesifisert i IEC 61131-3 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Configuration 

Resource 

Program 

Task 

Program 

Task 

Program 

Resource 

 FB  FB 

Global Variables 

POU 

Local 

Variable 

External 

Variable 

POU 

Local 

Variable 

External 

Variable 
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1.26 Library 
 

Et Library er normalt et sett med funksjonsblokker. Dette har endingen *.slr og kan lastes ned fra internett eller 

kjøpes. Be om å få en kopi av OEN_BaseBlocks før du går videre til neste punkt. 

 

1.26.1 Ta inn et Library i prosjektet 
 

Velg «Project» i menyen 

 

 
 

Trykk  i PopUp-bildet og hent filen OEN_BaseBlocks som du har fått utdelt. Funksjonsblokkene vil nå bli 

tilgjengelig i Toolboxen til høyre. Du kan ikke endre funksjonsblokker som ligger i et Library. 

 

I noen Library ligger det brukerveiledning på funksjonsblokkene. Disse kan du få frem ved å høyreklikke på 

dokumentet i kolonnen Attached Files. 
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1.27 Strukturer 
 

Strukturer er en fin måte å organisere dataene sine på. Strukturene lager du under Data->Data Types. En struktur er 

en slags mal som du kan bruke på mange like grupper av data. 

 

 
 

Strukturen til en ventil er fin å bruke som eksempel. 

 
Vi kaller strukturen for Ventil, og deretter legger vi alle egenskapene til en ventil inn som medlemmer av ventil. 

 

 
 

Deretter legger vi inn en ventil som har disse egenskapene i den globale symbollista. 

 
 

Legg merke til Data Type som dermed blir Ventil. 

Hvis vi har flere slike ventiler kan de også ha Data Type Ventil. 

 

Et lite programeksempel vil da kunne se slik ut: 

 

 
 

Elementene i strukturen finner vi med å sette punktum etter hovedsymbolet. Hvis alle aktuelle elementer ikke 

kommer opp i en valgbar meny, har du skrevet navnet på hovedsymbolet feil. 
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1.27.1 OPPGAVE: Pumpe som struktur 
 

Lag en datastruktur som inneholder alle elementene i oppgaven for pumpa. Skriv om programmet og legg det i 

Program1. 

 

Bytt om på Programmene i Task Settings slik at Program1 kjører i Primary og Program0 ikke kjører idet hele tatt. 

 

1.27.2 OPPGAVE: Pumpe1 og Pumpe2 
 

Lag globale variabler for 2 pumper med samme struktur. 

 

 

1.27.3 OPPGAVE: Trafikklys 
 

Lag et program som styrer de 3 lysene i trafikklyset sekvensielt. 

 

RØDT 

RØDT-GULT 

GRØNT 

GULT 

 

Bruk fast 2sek mellom hver gang det skifter. 

 

Legg til en inngang som kobler om systemet til blinkende gult. 

 

Legg til en puls-inngang som gjør at det grønne lyset lyser i 5sek når det har blitt grønt.  
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1.28 Lage et nytt prosjekt med lokale IO uten å gå Online 
 

 

Start Sysmac Studio frå Startmenyen. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.28.1 Offline oppsett av lokal IO «IO-Table» 
 

 

Vi setter her opp «IO-Table» manuelt: 

 

Bildet viser ein NJ, men det er same prinsipp for NX bortsett frå at moduler av typen CJ1W- ikkje kan brukast 

saman med NX. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Dobbel-

klikk 

Skriv inn 

søketekst 

«Drag and drop» 

Markèr 

modulen 

Endre namn til 

DO1 
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1.28.2 Generere variablar for lokal IO 
 

Slik genererer du variablar for alle korta i racket. Namnet til kortet vert sett inn først i variabelnamnet (DO1_). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Vi kan no opne «Global Variables» og sjå resultatet: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Variabelnamnet står du fritt til å endre. Pass på å ikkje endre teksten i AT feltet. 

 

 

 

 

 

 

 

 

 

 

1.28.3 OPPGAVE: Sett inn et analogkort og se hvordan det blir i IO Map 
 

1.28.4 OPPGAVE: Pumpestyring med analog utgang for hastighet 
 

1.28.5 OPPGAVE: Lag et EtherCAT-nettverk uten å gå online slik vi gjorde først 
  

Dobbel-

klikk 

Høgre-klikk 

Dobbel-

klikk 

Fysisk adresse 

Markèr og endre namnet til 

DO1_Valve_1 
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1.29 Oversikt over lagrede prosjekt 
 

 
 

Prosjektene er listet opp med detaljert beskrivelse. Man kan søke i lista hvis man kjenner prosjektnavnet eller man 

kan sortere ved å trykke på kolonnenavnet. Prosjekter med versjonsnummer vil dukke opp som en gruppe. 

 

Nederst vises disse 4 knappene: 

 

 
 

Properties for å endre navn på «eier», kommentarfelt eller passord. 

Compare for å sammenlikne et prosjekt med et annet. 

Delete for å slette ett eller flere prosjekt. Du kan merke flere samtidig. 

Open for å åpne prosjektet du har merket. 
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2 Sysmac Del 2 
 

2.1 POU 
 
Definsjonen av dei ulike POU 

 

Items Program Function Block (FB) Function (FUN) 

Task allocation Possible Not possible Not Possible 

Local variables The value is 
retained.  

The value is retained.  
Each instance has local 
variables.  

The value is not retained.  

Return value None None Yes 

In 
Algorithm 

Language LD, ST LD, ST LD, ST 

User defined FUN Possible Possible Not Possible 

User defined FB Possible Possible Not Possible 

Instance None Yes None 

Execution condition Always executed Always executed Specified by the EN input.  

EN/ENO None EN: None 
ENO: Yes (can be omitted.) 

EN: Yes.  
ENO: Yes (can be omitted.) 

 

Brukerdefinerte FB og FUN kan nøstast inntil 8 nivå. 

 

2.2 Generelt om Functions og Function Blocks 
 

Functions: 

Kan brukes i Program, andre Functions og i Function Blocks 

Kjører når EN=TRUE 

Krever ett sett variabelminne som blokka reserverer. 

ENO er normalt TRUE, men settes FALSE ved feil i blokka. Kan velges bort eller styres av kode i funksjonen. 

Gir alltid en Return Output. Typisk resultatet av funksjonen. Digital eller Analog. 

Utgangene "fryser" når ENO går av. De settes altså ikke til 0. 

 

Function Blocks: 

Kan brukes i Program og andre Function Blocks 

Kjører alltid. Bruk en digital inngang til å styre funksjonene i blokka. Bruk gjerne Enable eller Execute som første 

digitale inngang. Ikke EN. 

Hvert Instansnavn krever nytt sett med variabler. 

ENO er normalt TRUE, men settes FALSE ved feil i blokka. Kan styres av kode i blokka. 

En FB må ha minst 1 BOOL output. F.eks. ENO. 

Unngå å bruke Global variables i FBer. 

 

 

Se eksemplet på neste side som viser dette i praksis. 
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Her sammenlikner vi en addisjon gjort med en Function og en FunctionBlock. 

 

  Sum:=A+B; 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

På en Function må EN være TRUE for at kalkulasjonen skal kunne utføres. 

Signalene Enable og ENO er ikke lagt inn i programmet på FBlokka. Legg da merke til at FB-en kalkulerer likevel 

og at ENO=TRUE. 
 

  
Funksjonen kalkulerer bare når EN er på. 
 

  
Resultatet blir stående selv om EN=FALSE. Den nullstiller altså ikke variabelen på utsida. 
 
 

Her er Enable lagt inn som betingelse for kalkulasjon og ENO er betinget av Enable. Da vil den ikke kalkulere så 

lenge Enable er FALSE. 
 

 IF Enable THEN 

    Sum:=A+B; 

END_IF; 

 

ENO:=Enable; 
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2.2.1 Funksjonar 
 

Funksjonar har ikkje eit eige minneområde, og er ikkje i stand til å hugse verdiar frå ein «cycle» til neste. 

Ein funksjon kan kalle opp andre funksjonar, men ikkje funksjonsblokker. 

Funksjonar kan kallast opp utan å gje den instans-namn. 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.2.2 Funksjonsblokker 
 

Til forskjell frå CJ serien, vert funksjonsblokker utført kvar cycle. (Det finnes ikkje EN pinne) 

Ei funksjonsblokk kan kalle opp funksjonar og funksjonsblokker. 

2.3 Datatypar 
 

I tillegg til «Basic datatypes» som INT, BOOL, REAL etc har vi arrays, og en kan også lage sine egne datatyper. 

Dette er ganske nyttig når ein programmerar utan adresser. 

 

2.3.1 Array 1, 2 og 3 dimensjonale 
 

Arrays kan være 1 (liste) , 2 (tabell)  eller 3 (kube) -dimensjonale.  

 

Eksemplet nedenfor viser 3 slike arrays. I ladderen ser vi at tallet 1234 legges inn i kuben med koordinat x=1, Y=5 

og Z=3. 

Kuben som er laget nedenfor vil altså inneholde 10x10x10=1000 tallverdier. 

 

 
 

X kan jo da være reolnummer, Y kan være hyllenummer, Z er pallplass på hylla og tallet vil være antall varer på 

denne pallen. 

 

Arrays kan også være dynamiske i størrelse hvis du legger dem som in/out i en Function eller FunctionBlock. Det er 

praktisk hvis blokka skal kunne håndtere både 10 og 1000 variabler uten å ta opp unødig minne. 

 

 
(gjelder fra firmware 1.18) 

 

På mange av Funksjonane kan 

ein auke opptil 5 Input. 
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2.3.2 Stukturerte variablar «Datatypes» 
 

Vi skal bruke opplysningane knytta til ein startar for å belyse temaet. 

Dersom vi tenker oss at vi skal organisere data knytta til ein startar, kan det sjå noko slikt ut: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For å opprette ein slik datatype: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Legge til «Members» til sStartar: 

 

 

 

 

 

 

 

 

 

 

 

 

Forsett til alle «Members» er lagd inn. 

No kan vi lage ein «global variable» basert på denne datatypen: 

 

 

 

 

 

 

 

 

 

 

 

 

Namnet på datatypen («Struct»). 

«Members» til 

Datatypen. 

Dobbel-

klikk 

Klikk for å opprette ein 

«struct»  

Gje namn: 

Kan f.eks alltid starte med 

litan «s» for «struct» 

 

Høgre-

klikk 

Gje namn, og 

vel datatype 

Dobbel-

klikk 

Høgre-klikk 

vilkårleg i lista Gje Namn 

Vel din nye datatype 
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Når vi no skal programmere, vil det sjå slik ut: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Sett inn ein «Contact» 

og skriv «s» 

Pass på at Startar_1 

er markert, og trykk 

«.» 
Får no velje mellom 

«members» av 

Startar_1 Dobbel-klikk eller 

«ENTER» - tast for 

å velje.  
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2.3.3 Slik lager vi  ei funksjonsblokk for ein YD startar 
 

Start med å lage ein FB definition med namnet fbStartar. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

Legg til inngangar og utgangar som i denne tabellen: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Høgre-

klikk Høgre-

klikk 

Dobbel-klikk for å 

opne FB editoren 
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Legg til eit program som ser noko slikt ut: 

 

 

Sett no inn fbStartar i Program0 slik: 

Vi tek utgangspunkt i den strukturerte variablen «Startar_1» som vi laga her:  Stukturerte variablar «Datatypes» 
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2.3.4 Bruke same datamengde med ulike datatypar «Union» 
 

Dette er viktigare no når ein ikkje har fysiske adresser å forholde seg til. Ein kan sjå på same datamengde med ulike 

format f. Eks Word og Array[0..15] of BOOL.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Som en ser i eksemplet kan altså variabelen Tall_A både være et Word og et Bit-array hvis en definerer den som en 

Data Type  med Base UNION. 

 
Som en ser 
 

2.3.5 Variablar med førehandsdefinerte val «Enumerators» 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Vi kan no velje mellom førehandsdefinerte fargar: 

Namnet på 

Union 

Members til 

uWord_Bit 

Variabel med uWord_Bit 

som datatype 

 

Adresserer som bit 

 
Adresserer som ord 

Høgre-klikk 

vilkårleg i lista Gje Namn 

Vel din nye datatype 
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2.4 Allokering av Datatyper 
 

2.4.1 Offset Type NJ 
 

Vi tar først for oss standardmetoden for allokering av datatyper. For denne metoden gjelder regelen om at alle 

variabler eller BOOL-rekker opptar 4 byte minne i CPUen. Vanligvis bryr vi oss ikke om dette, men når vi skal 

koble lokale data mot remote data, f.eks. via Ethernet/IP, må vi ta hensyn til dette. 

 
Denne datatypen med Offset "NJ" vil oppta 12 bytes.(sCommands=4byte. sStatus=4+4byte) 

   
 

En sammenhengende rekke av BOOL vil allokere 4 byte. 

Alle variable vil allokere 4 byte. 

 

2.4.2  Offset Type User 
 

I dette eksemplet styrer vi selv variablene mot spesifikke byte i OffsetByte-kolonnen. 

 
Her vil sCommands allokere bare 2 byte og sStatus bare 3+1(ledig) byte.  

 

Samme resultat oppnås med offset "CJ". (Husk å velge Update på uthevede verdier.) 
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2.5 Strukturert programmering 
 

For å få programmet mest mulig strukturert, er det en fordel hvis en kan lage flest mulige funksjonsblokker for 

isolerte oppgaver. I tillegg bør en lage datastrukturer, slik at isolerte variabler blir gruppert under et hovednavn. 

Typiske datastrukturer vil være Pumpe, Fyllestasjon eller Ventil. Disse objektene har mange variabler knyttet til seg 

på samme måte som kontaktlista i en mobiltelefon. Disse variablene legger vi i en datastruktur. 

For å koble fysiske I/O til datastrukturer, kan det være en fordel å bruke funksjonsblokker.  

 

 
 

Eksemplet viser en 8-punkt inngangsmodul navnsatt som N001_U002_DI. Inngangene på denne modulen kobles 

mot variablene i datastrukturen ventil, i dette tilfellet en Vannventil. 

På samme måte kobles utgangene fra datastrukturen til de fysiske utgangene på utgangsmodul N001_U003_DO. 

Navnene på de fysiske modulene definerer du i «I/O Map» 

 

. 

Typiske navn du bør bruke på inngangene vil nå være komponentnummer fra EL-skjema og ikke Vannventil_Åpen. 

Disse navnene vil du normalt ikke bruke i selve programmet. 

 

En typisk løsning for analoge innganger vil være å bruke denne funksjonsblokka: 

 

 
 

Her får vi korrekt og skalert verdi på Romtemperaturen og i AI1 datastruktur.. 

 

 

 

 

Blokkene ovenfor finner du i et eget Library kalt OEN_BaseBlocks. Se kapittel 6 i boka. 
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2.6 Grupperingsfunksjon 
 

Globale variabler og programmer kan legges i grupper slik at det blir lettere å se hva som henger sammen. View-

menyen har et valg kalt Programming Group Tab Page. Her kan du få oversikt over gruppene dine. 

 

Globale variabler 

Velg ut de globale variablene du vil legge i en felles gruppe. (Pass på så hele linja er merket ut, ikke bare navnet) 

Høyreklikk og velg Group settings. 

Nå kan du lage ny gruppe eller legge dem til eksisterende.  

Med Filterfunksjonen i lista med Global Variables kan du nå se gruppene dine eller alle grupper. 

 

 
 

Programmer 

Høyreklikk når du er inne i Programming Group Tab Page og velg en av disse to: 

 

Velg programmene som skal tilhøre samme gruppe. 

 

  

 

2.7 Flerbrukerløsning og versjonskontroll 
 

Med en egen Pluginlisens kan du utvide Sysmac Studio til å håndtere flere brukere på samme prosjekt og 

versjonskontroll.  

 

 
Flerbrukerløsningen styres av en egen gratis Git-software og krever en felles lokasjon for prosjektet. 

 

 
 

Versjonskontrollen holder rede på alle endringer, når de ble gjort og hvem som gjorde det. Les mer om alt dette i 

Manual W589. 
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2.8 Lage et eget Library 
 

For å lage et Library, begynner du på samme måte som et vanlig prosjekt, men du velger Library Project under 

Type.  

 

 
 

Når du har laget og testet funksjonsblokkene dine, velger du «Project» i menyen: 

 

 
 

Under «Library Setting» fyller du inn nyttig informasjon om navn og versjon osv. Deretter velger du «Create 

Library» i menyen og oppgir en mappe og filnavn for ditt Library. Det er nå mulig for andre å ta denne fila inn i sitt 

prosjekt som beskrevet i punkt ?.1. 

 

Fordelen med Library er at du enkelt kan ta funksjonsblokkene dine inn i nye prosjekt, du kan dele dem med andre 

og du kan passordbeskytte dem. 

 

  

mailto:support.norway@omron.com


 
Postadresse:  Besøksadresse:  Telefon:   22 65 75 00  Foretaksregisteret: 

Postboks 109, Bryn Ole Deviks vei 6B Support:   23 17 39 40  NO 852 345 632 MVA 

N-0611 Oslo  0611 OSLO       

support.norway@omron.com   64/194 

 

2.8.1 Namespace 
 

Hvis du lager mange Functions og FunctionBlocks kan det være nyttig å gruppere dem.  

 

 
 

Under Properties på blokkene finner du et felt for Namespace. Her kan du lage grupper, undergrupper eller bruke 

noen du har laget tidligere. Når du skal bruke Functions og FunctionBlocks i programmet ditt må du referere til 

gruppenavnet.  

 

Enten slik: 

 

 

 

 

 

 

 

 

 

Eller ved å liste opp de aktuelle gruppenavnene slik: 
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2.9 Ethernet/IP 
 

IP-adressen til Ethernetporten velger du under Controller Setup: 

 
 

 
 

Tabellen nedenfor viser egenskapene til CPUer og enheter som støtter Ethernet/IP. Typisk vil hver node som du skal 

knytte deg til, kreve minst 2 Tag Sets. Pass på å ta høyde for dette når du prosjekterer anlegget ditt. Hver node vil 

være en Connection. 

 

 
TD-ref: Ethernet/IP - Units, Gateway, Ports and capacity  
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2.9.1 Oppsett av kommunikasjon med NX-node 
 

De som ønsker å prøve dette i praksis, trenger et NX-EIC kort. 

 

 
 

 

Skal du kommunisere med NX-EIC, velger du dette med + i Toolboxen til høyre: 

 
 

Trykk ADD for å få den inn i Target Device-lista. 

 

Legg merke til at det er en grense på 32 Tag Sets totalt for Input og Output. Et Tag Set kan bestå av inntil 8 

variabler, men alle må komme fra samme node. Ofte har vi flere Tag Set på samme node, og da kan en fort nå taket 

for hvor mange noder en NX102 kan kommunisere med. Alternativ løsning er tilleggsmodulen CJ1W-EIP21, men 

da må du bruke NJ. 

 

For å kunne overføre data til/fra NX-EIC, må en vite antall byte inn og ut for NX-EIC. En enkel måte å finne ut det 

på, er å koble seg til NX-EIC og lese inn konfigurasjonen: 

 

 
På nederste linje her ser man at noden har 24 byte input og 8 byte output. Dette blir utgangspunktet for å lage et 

TagSet til CPUen og et TagSet fra CPUen. Enkleste måte er å lage to array på 24/8 byte eller 12/4 word slik som 

her: 
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Pass på å sette riktig Network Publish. Hvis ikke, vil du ikke kunne bruke dem i dine TagSet. 

Dette er altså ikke Tag Sets, men variabler som skal tilhøre TagSets. 

 

Setter du Network Publish=Publish Only kan du ikke bruke dem i TagSet men derimot gir du Software og 

operatørpaneler tilgang til variablene.  

 

En litt mer elegant måte er å lage strukturer eller Tags som relateres til hva slags moduler som står på noden. Den 

metoden vil gjøre det mye enklere å skille dataene fra hverandre. 

 

Deretter lager vi TagSets som inneholder disse variablene: 

 
 

Til slutt kobler vi TagSet sammen med dataene som kommer fra Noden: 

 

 
 

Legg merke til Target Variable som i dette tilfellet er tall. Disse tallene er forhåndsdefinert som nummeret på data 

som overføres. Dette vil du finne igjen på mange andre typer noder også. 

 

Om ønskelig kan en lage TagSets i noden på samme måte som i CPUen. Disse må da importeres i Sysmac Studio 

hvis du vil bruke dem istedet for tallene. 

 

Overfør konfigurasjonen til CPUen med knappen nederst på skjermen. 

 

 
 

Hvis du ikke har overført de globale variablene tidligere, må du gjøre en full synkronisering også. 

 

Riktig oppsett skal gi faste grønne lysdioder på EIC i tillegg til hurtig blinking på lampene for portene. 
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Nedenfor er et eksempel på den noe mer elegante måten å lage Tag Settene på: 

 

 
 

Pass på så du ikke overskrider grensa på 8 Tags per TagSet. 

 

 
 

 

 

2.9.2 OPPGAVE: Utveksle data med andre NX102 
 

Lag Tags og TagSet og koble disse opp imot andre CPUer på kurset. Legg inn data i taggene og observer at de blir 

overført til de andre. 
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2.10 FINS 
 

FINS er Omrons egen kommunikasjonsprotokoll. Det finnes mange slike protokoller. Modbus er en veldig kjent 

protokoll. Den kan du bruke både på seriell kabel og ethernetkabel. EtherCAT og Ethernet/IP er protokoller som 

bare brukes på Ethernet. FINS bruker vi normalt bare på seriell kabel og Ethernetkabel, men den virker også på 

DeviceNet. FINS bruker Nodenummer og nettverksnummer for å adressere seg frem til mottakeren. 

Nettverksnummeret blir som en gate i en by og nodenummeret blir husnummeret. Dermed kan postbudet (som bare 

har en gate som sitt ansvar) finne frem til riktig hus. 

 

Verd å merke seg er at: 

NX1P2 støtter bare den serielle HostLinkprotokollen over FINS. Hostlink C-mode går altså ikke. 

NX7 og NX1P2 kan ikke sende FINS-meldinger. De kan bare motta og svare på slike. 

NX102 kan både sende og motta FINS-meldinger, men det er bare Port#2 som supporterer dette. 

 

Med disse begrensningene anbefaler vi derfor sterkt å benytte Ethernet/IP ved kommunikasjon mellom CPUer. 

2.10.1 Routing Table 
 

Routing table bruker vi når vi sender FINS-telegrammer over nettverk. Både EthernetFINS og DeviceNet bruker 

Routing. Routing er helt nødvendig når vi skal sende post fra en gate i nettverksbyen til en annen. PLSen som har 

ansvaret for routingen må da vite hvilket postbud som skal levere telegrammet. Routing Table setter vi opp i CX-

Integrator. 

2.10.2 NJ og NX1P har CJ sin minnestruktur i tillegg 
 

Vanligvis bruker vi Ethernet/IP-protokollen når vi skal kommunisere med NJ. Det finnes imidlertid situasjoner hvor 

dette ikke er mulig. Det gjelder spesielt operatørpaneler som ikke støtter Ethernet/IP, men som bruker FINS-

protokollen. FINS har ikke støtte for Tagnavn, altså må vi bruke CIO, D, H og W slik som vi kjenner fra eldre PLS-

modeller. NJ har gjemt bort sine CIO, D, H og W i en mørk krok. For å kunne ta dem frem, må vi tilordne 

variabelnavn som vi er vant med fra symbollista i CxProgrammer. Legg merke til at vi nå må sette % foran adressen. 

Operatørpanelet får nå tak i innholdet i variabelen ved å spørre på adresse som vanlig. 

 

Manualen forklarer dette på følgende måte. 

 
 

Under Globale Variabler tilordner vi dette i AT-kolonnen. Dette blir litt motsatt av hva vi er vant til fra 

CxProgrammer, hvor vi tilordner et Tagnavn til en adresse. 

 

 

 

 

 

 

 

 

 

 

 

For NX1P2 må du først aktivisere FINS-adresser for å kunne allokere dem til Globale Variabler. Det er gjort slik for 

å begrense minnebruk. 
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Valget over gir mulighet for å allokere DM0-DM99 i Global Variables. 
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2.11 NTP protokoll 
 

For å synkronisere klokka i PLSen med internett kan en bruke NTP, vanligvis via Port 123. Oppsettet nedenfor 

synkroniserer klokka en gang i timen, men andre valg kan også brukes. 

 

 
 

For å få tilgang til NTP-serveren angitt ovenfor, må vi i tillegg legge til følgende informasjon. 8.8.8.8 er for øvrig 

Googles DNS-server. 

 

 
 

Default Gateway er den lokale IP-adressen til Routeren din og trenger ikke være samme adresse som i eksemplet. 

Noen ganger må du også åpne Port 123 i Routeren for at dette skal fungere, men normalt er den vanligvis åpen. 

 

2.11.1 NTP Server i PC 
 

Du kan også sette opp PCen din til å være en NTP-server.  

 

Enabling the NTP server service requires a quick registry modification. Open Regedit and navigate to 

HKEY_LOCAL_MACHINE \ System \ CurrentControlSet \ Services \ W32Time \ TimeProviders \ NtpServer  

and change Enabled from 0 to 1 
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2.12 Protokoll for filoverføring FTP 
 

 

 
 

Oppsett for å få tilgang til filene på SD-kortet i PLSen fra en PC. Passordet må være minimum 8 bokstaver/tall. Du 

kan dermed logge deg på med en browser eller et FTP-klientprogram. (eks. FileZilla) 

2.12.1 OPPGAVE: Lag en logging til SD-kort og hent filen med FileZilla 
 

Bruk gjerne Funksjonsblokkene Table_Logging10Col og  SDLogging10Col i Library OEN_BaseBlocks. 

Variabelen Today kan du få fra Funksjonsblokka DateAndTime. 
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2.13 DIP-switcher på CPUen 
 

Under lokket på CPUen finner du 4 DIP-switcher. Disse brukes normalt til Backup og Restore av alle data i CPUen. 

I tillegg kan du få overført data som ligger på et SD-kort til CPUen hver gang du setter på strømmen. 

 

Noen ekstrafunksjoner er som følger: 

Safe Mode kan sammenliknes med Windows Safe Mode. CPUen starter opp med et minimum av funksjoner og 

programmet starter ikke. Bruk denne hvis du har problemer med å få kontakt via Sysmac Studio. 

 

Åpne for tilgang til CPUer med Firmware 1.49 eller høyere med integrert Secure Communication. Denne er nyttig 

hvis enheter uten SecureCommunication benyttes i samme anlegg eller hvis du har mistet Securitypassordet. Secure 

Communication har blitt lagt til i Firmware 1.49 (NJ/NX1), 1.29 (NX7) og 1.16 (NA) for å hindre uautorisert tilgang 

til CPU og program. Typisk hvis CPUen er tilkoblet internett. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 
Utklipp fra Manual W500 

 

Et prosjekt laget for Firmware 1.49 eller nyere vil bli overført kryptert til CPUen fra Sysmac Studio. 
 

Hvis du har SysmacStudio versjon 1.49 eller eldre (ukryptert) og en CPU med Firmware 1.49 eller nyere (kryptert), er det ikke samsvar 

lenger. For å kunne overføre prosjektet, må du sette på DIPSW#1 og #2 for å slå av krypteringen på CPUen.    
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2.14 Backup og Restore 
 

Backup brukes til å lagre data i CPUen til et SD-minnekort. Restore overfører en Backup tilbake til CPUen.  

 

Backupfunksjoner: 

1 Backup kan gjøres manuelt ved hjelp av DIPSW#3 på CPUen. 

2 Backup kan gjøres med en FB i programmet. «BackupToMemoryCard». 

3 Backup kan gjøres via Tools-menyen i SysmacStudio. Her blir du spurt om hvor du ønsker å lagre 

backupfilene dine. 

4 Backup av Retainvariabler kan gjøres via Tools-menyen i SysmacStudio 

 

En Backup tar 30-60 sekunder og filen blir noen få Mbyte. 

En Backupfil kan importeres inn i Sysmac Studio fra et SD-minnekort.  

Et prosjekt kan eksporteres fra Sysmac Studio og lagres som Backup på SD-minnekort 

Backup kan blokkeres med en setting i SysmacStudio. (kopibeskyttelse). «OperationSettings/SecuritySettings» 

 

Backup lagrer Program, Settings, DataTyper, Retainvariabler, EtherCAT slaveparameter osv. Se 9-1-3 i manual 

W501. 

 

Restorefunksjoner: 

1 Restore kan gjøres manuelt ved hjelp av DIPSW#3 og #4 på CPUen. 

2 Restore kan gjøres med flere forskjellige systemvariabler, altså via programmet.  

_Card1RestoreCmd (Struktur hvor 6 valg ligger i separate variabler) 

_Card1PrgTransferCmd (Struktur hvor 4 valg ligger som strukturvariabler) 

(CPUen og slavene må deretter restartes manuelt). Det er flere valgmuligheter her mhp. hva man 

ønsker å ta med i Restore. 

3 Restore kan gjøres via Tools-menyen i SysmacStudio 

4 Restore av Retainvariabler kan gjøres via Tools-menyen i SysmacStudio 

 

.dat-filen kan bare Restores på en controller av samme type, f.eks. NJ. 

 

Merk at det er visse begrensninger med flere av disse alternativene. Se kapittel 9-1 i W501. 

 

Slik tar du en Backup manuelt: 

 

1 Sett inn et SD-minnekort i CPUen 

2 Sett DIPSW#3=On 

3 Trykk på den sorte knappen nedenfor minnekortet i 3 sekunder. 

4 SD PWR vil nå blinke 3/0.5sek 

5 Når SD PWR lyser fast, har du en Backup. 

6 Sett DIPSW#3=Off 

7 Ta eventuelt ut SD-kortet, men trykk først den sorte knappen hvis SD PWR lyser 

 

Slik tar du en Restore manuelt: 

 

1 Slå av strømmen på CPUen og alle EtherCAT slaver 

2 Sett inn et SD-minnekort med en Backup 

3 Sett DIPSW#3=On og DIPSW#4=On 

4 Slå på strømmen på CPuen og alle EtherCAT slaver 

5 SD PWR vil nå blinke 3/0.5sek 

6 Når SD PWR lyser fast, har du overført Backup til CPUen og slavene 

7 Trykk den sorte knappen for å slå av SD PWR 

8 Slå av strømmen på CPUen og alle EtherCAT slaver 

9 Sett DIPSW#3=Off og Dipsw#4=Off 

10 Ta eventuelt ut SD-kortet 

11 Slå på strømmen på CPuen og alle EtherCAT slaver 
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Slik lager du en Backup i programmet: 

 

«DirName» er mappa som backupfilene skal legges i. 

 
 

Slik kan du lage en Restore i programmet: 

 

Tillat Restore fra program med dette valget. Legg eventuelt inn et passord som korresponderer med det du setter i 

eksemplet nedenfor. 

 
 

 

 
Legg merke til at du kan velge vekk deler av Backupen ved å sette variabler FALSE i eksemplet. 

Med _Card1RestoreCmd kan du også ta med Slave- og Encoderparameter.  

 

Husk at controlleren tar en automatisk reboot før Restore begynner. Den går heller ikke i RUN før Restore 

er ferdig. 

 

Backup med SysmacStudio: 

 

«Tools/Backup/Backup Controller..»  

Ved Backup av data kan man velge hva som skal være med. Filformatet blir .dat. 

 

«Controller/SDMemoryCard…» 

Man kan også ta Backup av controlleren over til SD-kortet med SysmacStudio som om man kjørte den manuelle 

prosedyren.  

 

«Tools/Backup/BackupVariablesAndMemory» 

Velger man mer enn Retainvariabler lagres alt på filformat .xml. 

 

Velger du bare Retainvariabler, må du velge de variablene du ønsker å ta Backup av med knappen 

«SelectVariables». Filen kan da lagres som .csv og man kan dermed gjøre endringer i denne med f.eks. Excel. 
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Restore med SysmacStudio: 

 

«Tools/Backup/Restore Controller..»  

Ved Restore av data kan man velge hva som skal være med.  

 

«Tools/Backup/RestoreVariablesAndMemory» 

Ved Restore av Retainvariabler kan du velge bort variabler du ikke ønsker å Restore. Restore av variabler er 

controlleruavhengig. En csv-fil fra NJ kan godt Restores i en NX1P om ønskelig. Restore må gjøres i PROGRAM-

mode. 
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2.15 Kopi, endring og innsynsbeskyttelse 
 

Hvis du legger inn et passord på Project Properties vil det ikke være 

mulig å åpne prosjektet i Sysmac Studio uten rett passord. 

 

Sørg for å ta vare på passordene du legger inn. Ingen kan hjelpe deg med 

å finne dem hvis du mister dem. 

 

 

 

 

 

 

 

 

 

 

Når du overfører programmet til Controlleren kan du 

krysse av for "Do not transfer POU program source". Da 

vil det ikke være mulig å overføre program fra CPUen til 

SysmacStudio etterpå. 

 

 

 

 

 

 

 

 

Controller>Security>Setting of Op 

Authority 

Med dette valget aktivert i 

Controlleren kan du sette passord på 

5 forskjellige nivå som begrenser 

tilgangen til funksjoner som 

påvirker CPUen i Sysmac Studio. Se 

8-3-1 i W504 for detaljer om 

nivåene. 

Controller>Security>ID for User 

Program Exec 

Med dette valget Online kan du sikre deg at bare program med kjent ID kan kjøres på CPUen. 

Reboot Controlleren for å aktivere ID-sjekk. 

Samme ID må nå legges inn i programfila når du er Offline. 

(Controller>ClearAllMemory sletter ID). 

Controller>Security>CPU WriteProtection 

Velger du dette kan du hindre utilsiktede endringer i programmet. Samme menyvalg gjelder for Unprotect. 

WriteProtection kan også aktiveres automatisk etter strømbrudd på OperationSettings. 

OperationSettings>SD Memory Card  

Her har vi 3 valg for SD Memory Card. 

 

1-Overføring av program fra SDMC til CPU 

beskyttet av passord. 

 

2-Restore av data fra SDMC til CPU beskyttet av 

passord. 

 

3-Forhindre mulighet til å ta backup av program til SDMC. 
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>Security>Data Protection Setting 

Programs, Functions og FunctionBlocks kan beskyttes 

med passord på 3 måter: 

Ingen mulighet for å kopiere dem 

Ingen mulighet for se innholdet 

Ingen mulighet for å endre på dem 
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2.16 Håndtering av prosjektvarianter 
 

Med Sysmac Studio kan du ha flere controllere i samme prosjekt. De kan ha hvert sitt individuelle oppsett eller de 

kan dele på ressurser. 

Ressursdeling er interessant hvis du har flere varianter av samme maskin. Da vil du kunne gjøre en endring i 

programmet (Common POU) som skal gjelde for alle variantene. Andre deler av programmet (Derived POU) kan 

gjelde bare den ene varianten. Vi kan også se for oss maskiner med mye eller lite hardware, men som likevel kan 

kjøre samme program. 

Ressursdeling krever minimum Firmware 1.16. Bruk menyen «Insert/Derive Device» for å legge til varianter som 

skal bidra til ressursdeling. 

 

Figuren viser hvordan man kan benytte seg av denne funksjonen: 
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2.17 Routing 
 

Routing bruker vi når vi skal kommunisere fra ett nettverk til et annet. Vi skal her se på et eksempel som illustrerer 

hvordan man kan konfigurere CPUene slik at dette kan fungere. 

 

 

 
 

Her har vi 3 CPUer i subnett 192.168.250. 1 CPU og PC i subnett 192.168.251 og 1 CPU og PC i subnett 

192.168.252. Målet er å gi PC_1 og PC_2 tilgang til NJ501. 

 

1) Vi må sette en IP-adresse i NJ501 som korresponderer med det subnettet den står i slik det første bildet 

viser. 

 
2) Deretter må vi fortelle NJ501 hvor subnett 192.168.251 og .252 befinner seg, slik at den kan svare på 

meldinger fra både PC_1 og PC_2. Det gjør vi med IP Router Table. Her sier vi at for å kunne snakke med 

PC_1 som er i subnett .251 må NJ501 sende data via 192.168.250.2. Det samme prinsippet gjelder for 

PC_2. Hvis NJ501 nå får en melding fra PC_1, vet den at svaret på meldingen skal sendes til NX102_1. 

NX102_1 vil deretter videresende svaret til PC_1. 

 
3) PC_1 trenger også å konfigureres slik at den vet hvor NJ501 er. Dette kan gjøres ved å sette Default 

Gateway til 192.168.251.1. Da vil alle meldinger som ikke tilhører subnett .251 bli sendt til NX102_1. 

 
4) NX102_1 må også vite hva den skal gjøre med meldinger som ikke tilhører den selv. Typisk vil vi enable 

IP Forward slik at den videresender data fra den ene ethernetporten til den andre. 

I NX102 trenger vi ikke å gjøre noe med IP Router Table siden den er med i begge subnettene. 
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5) For PC_2 og NX102_2 blir prinsippet det samme. 

 

IP Router Table blir som en instruks for en postbil som kjører fra en postterminal til en annen. Deretter blir posten 

fordelt av et postbud som tilhører aktuell postterminal. 

 

Default Gateway blir som en postkasse på hjørnet, hvor vi overlater ansvaret med å levere brevet til den som 

tømmer kassen. 

 

Destination Mask IP Address er et slags filter som gir oss muligheten til å sende brev til samme subnett via flere 

postterminaler. Dette brukes i mer komplekse løsninger, så sett 255.255.255.0 her. 
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2.18 NATing 
 

NAT- Network AddressTranslation kan brukes til å gjemme IP-adressen eller sub-nettet bak et portnummer. Hvis en 

enhet på et eksternt nettverk skal snakke med en enhet på et internt nettverk (Private) kan man bruke NAT for å 

skjule den interne enhetens IP-adresse. 

 

Ser vi på tegningen under, er 10.0.0.1 den hemmelige IP-adressen. Host sender data til Server. Routeren bytter ut 

10.0.0.1 med sin egen IP-adresse, så det ser ut som om det er Routeren som sender data til serveren. Når Serveren 

svarer på meldingen, vil Routeren bytte tilbake Host sin IP-adresse og sende svaret dit det skal. For at Routeren skal 

holde styr på hvem som skal ha svaret, legger den også med et eksternt portnummer som en slags ID. Denne ID 

kommer også tilbake sammen med svaret. Dermed har Routeren full kontroll på riktig mottaker. 

 

 
 

En typisk NATing som må legges i Routeren for Ethernet/IP kan vi se på de to første linjene her: 

 

 
Alle data fra 192.168.56.2 får enten ID 2222 eller 44818 før Routeren sender det videre sammen med sin egen IP. 

 

Hvis Server skal sende data til Host, må den bruke riktig portnummer, samt IP-adressen til Routeren. Har vi flere 

CPUer i Private network, kan vi bruke samme portnummer på alle for Ethernet/IP. I andre tilfeller kan det hende at 

hver CPU må ha sin unike port ID. 

 

Bildet under viser adresser og dataflyt med en mobilrobot som Router med NAT: 
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3 Sysmac Motion 
 

3.1 Tools-menyen 
I Tools-menyen er det to valg som er relatert til Motion. 

 

«Import ST Program...» 

Her kan du importere et ST-program utviklet i SimuLink fra MathWorks. Se MathWorks sine websider for mer info. 

 

«Import Motor sizing tool results» 

Hvis du bruker Omrons gratis “Sysmac Servo Sizing tool” kan du importere prosjektfilen inn i SysmacStudio. Det 

vil spare deg for en del dobbeltarbeid.  

Programmet kan du få tilsendt på forespørsel, og her kan du legge inn gir og last for å beregne riktig servo i 

applikasjonen. 

 

  
 

Se også manual I820. 
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3.2 Oppsett av EtherCAT 
 

Gå «Online» for å kunne søkje etter slavane automatisk: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gå «Offline» for å kunne endre namn på servoforsterkarane: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.2.1 Generere variablar for EtherCAT 
 

Vi skal no generere variablar for slavane. 

  

Dobbel-

klikk 
Høgre-

klikk 

Fann 2 slavar 

Markèr slave 1 Endre namn 

Markèr slave 2 
Endre namn 
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Dobbel-

klikk 

Høgre-

klikk 

mailto:support.norway@omron.com


 
Postadresse:  Besøksadresse:  Telefon:   22 65 75 00  Foretaksregisteret: 

Postboks 109, Bryn Ole Deviks vei 6B Support:   23 17 39 40  NO 852 345 632 MVA 

N-0611 Oslo  0611 OSLO       

support.norway@omron.com   86/194 

 

3.3 Legge til servo akser 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.3.1 Konfigurere aksar 
 

Vi skal no knytte Node 1 (Band) til vår nye akse (AX_Band): 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Vi skal no skalere aksen: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Det er ikke alle motorer som har 1048576 pulser per omdreining. Sjekk datablad for aktuell motor for å finne riktig 

pulstall.  

Høgre-

klikk 

Høgre-

klikk 

Dobbel-

klikk 

Bandet bevegar seg 100mm for kvar omdreining på motor, 

og motoren har 1048576 pulsar pr. omdreining (20bit) 
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Vi legg inn hastighetsbegrensingar på aksen: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Legg til «Axis 1» knytta til node 2 på same måte. Kall denne for AX_Hjul. 

Denne kan f.eks skalerast til 360° pr. 1 048 576 pulser. 

 

 

 

 

 

 

 

 

 

 

Legg inn maks hastighet 18000° pr. sek. (Tilsvarar 3000 rpm på motor) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

5000 mm/s 

tilsvarar 3000rpm 

på motor 
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3.3.2 Oppsett av «Homing» 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Sett opp AX_Hjul også, men med Homing velocity=720 deg/sec og Homing approach velocity = 36 deg/s 
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3.3.3 Kor finn ein data knytta til aksane? 
 

Kvar akse får ein «global variable» med same namn som aksen. 

 

 

 

 

 

 

 

 

Vi ser også at variablane er merka som «constant». Dette betyr at ein ikkje kan endre dei frå programmet. 

Ein kan hente ut data som ein ynskjer, men det er kun «Motion Controller» som kan endre data. 

Dersom ein skal påverke aksane frå programmet, skjer dette gjennom bruk av funksjonsblokker. Sjå eit utval under: 

 

 

 

 

 

Dersom vi ser nærare på variabelen AX_Band, ser vi at dette er ein strukturert variabel (også kalt ein datatype) med 

mykje data. 

Under AX_Band har vi underkategoriar som «Act», «cfg», «Cmd» etc. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Under «Actual» finn ein 

noverande posisjon, 

moment og hastighet. 

Under «DrvStatus» finn ein status om 

servoforsterkaren, slik at ein treng som 

oftast ikkje forholde seg til anna enn 

aksen. 
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BufferMode 

 

Ofte vil vi kjøre servobevegelser rett etter hverandre. Det finnes 6 forskjellige valg hvordan overgangen skal være. 

Valgt BufferMode på den aller første kommandoen i "rekka" har ingen funksjon. 

En kan ikke legge mer enn en kommando i ventebufferet. (For aksegrupper kan en ha opptil 7 kommandoer i 

ventebufferet.) 

 

Aborting:  Avbryter kjøringen av forrige kommando og starter kjøring av denne. 

Buffered:   Starter kjøringen av denne når Done=True (mål#1 er oppnådd) på forrige kommando. 

BlendingHigh;  Hastigheten når bevegelsen treffer mål#1 er lik den høyeste hastigheten som er valgt i 

kommando for mål #1 og mål#2.  

BlendingLow:  Hastigheten når bevegelsen treffer mål#1 er lik den laveste hastigheten som er valgt i 

kommando for mål #1 og mål#2.  

BlendingPrevious:  Hastigheten når bevegelsen treffer mål#1 er lik hastigheten som er valgt i kommando for 

mål#1.  

BlendingNext:  Hastigheten når bevegelsen treffer mål#1 er lik hastigheten som er valgt i kommando for 

mål#2. 

3.3.4 Legge til eit lite program 
 

Før vi kan synkronisere med «machine controller» må vi legge inn eit lite program: 

 

 

 

 

 

 

 

 

 

 

Når programmet er ferdig, gjennomfør «Check All Programs»: 

 

 

 

 

 

 

 

 

 

 

3.3.5 Synkronisere prosjektet med «Machine Controller» 
 

Gå «online» og synkroniser: 
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3.3.6 Endre parameter i Servoforsterkarane 
 

Parametera som vi no endrar vert lagra i prosjectet. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Vi må no endre parameter Pn403.0, Pn403.1 og Pn403.2 til «Disabled». 

Dette på grunn av at denne inngangen var i utgangspunktet sett opp som «Proximity Sensor». 

Gjenta samme prosedyre for Node 2. 

 

No kan du ta strømmen av og på for heile trainaren.   

Høgre-klikk 

Dobbel-klikk 

«Transfer from Drive» 

1. 
Endre desse 3 parameter til 22, 

for å knytte fotocella inn som 

«Proximity Sensor». 

2. 
Markèr dei 3 parametera og 

høgre-klikk 

3. 
Overfør til forsterkaren 
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3.3.7 Testkøyring av aksane 
 

Vi skal no test køyre AX_Band: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gå til fane «Homing», vi skal no teste «homing» sekvensen:  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Høgre-

klikk 

Trykk på «Play» og bandet skal gå til Fotocella 

«ser» det kvite filtet på bandet («Proximity 

Sensor»), skal no snu retning og gå sakte for å 

søkje etter Z-phase på encoder. 
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Vi forstsetter med litt «Relative positioning»: 

100 mm = 1 rotasjon på motor. Vi kan no sjekke om skaleringa er riktig. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
  

Legg inn avstand og 

hastighet. 

Trykk «Apply» 

Når ein trykker 

«Play» går motoren 

1 omdreining. 
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3.4 Datatracing 
Sysmac Studio har et meget avansert verktøy for datatracing og logging. Vi skal se litt nærmere på det. 

 

Legg til en ny DataTrace, og vi får opp bildet til høyre som viser alle menyvalgene samt to grafer. En for analoge 

verdier og den nederste for digitale. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

Følgende oppsett vil logge hastigheten på servomotoren hvert 100ms i 2 minutter. Loggingen starter vi med den 

røde knappen i venstre hjørne. 

 
 

 

Vi kan også starte logging på en hendelse (Execute_Move), slik at vi slipper å logge imens den står i ro. Vi kan til 

og med få med oss f.eks. 90 loggepunkter FØR triggeren går på. Husk å trykke den røde knappen før du starter 

motoren. 

 
 

 

Som X-akse kan du velge Time som er velkjent. Men du kan også bruke loggedata som X-akse. Dermed vil du 

kunne se dine data i forhold til andre data. For eksempel hastighet i forhold til posisjon osv. 

 

Med denne knappen kan du ha forskjellig skala på Y aksen avhengig av hvilken variabel du har valgt. 

  
 

Csv-filer kan både importeres og lages ut ifra loggedata. Når du importerer, kan du dermed sammenlikne nye 

loggedata med gamle og se forskjeller. 
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4 Test av funksjoner med NA eller NS-panel 
 

4.1.1 Lag et NA-prosjekt for betjening av starteren 
 

Legg til en NA (HMI) i prosjektet ved å høyreklikke på CPU-konet. 

 

 
 

CPUen din vil komme opp automatisk under Internal Devices. Her vil alt være ferdig utfylt. 

 

  
 

Under Variable Mapping vil du finne de Globale variablene dine i CPUen. 

 

 
 

Høyreklikk på Startar_1 og lag en HMI-variabel med «Create Device Variable». HMI-variabelen får nå CPUen sitt 

navn som Prefix. Det kan derfor være smart å ha litt kortere navn enn dette på CPUen sin. 

 
 

Gå til Page og lag 3 lamper og to knapper slik: 
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Endre egenskapen til knappene og lampene under Properties. Under Variable for Start-knappen legger du: 

 

  
 

Fortsett på samme måte for Stopp-knappen og lampene. 

 

Deretter kan du simulere prosjektet med: 

 

 
 

Gå videre til kapittel 4.3. 

 
  

mailto:support.norway@omron.com


 
Postadresse:  Besøksadresse:  Telefon:   22 65 75 00  Foretaksregisteret: 

Postboks 109, Bryn Ole Deviks vei 6B Support:   23 17 39 40  NO 852 345 632 MVA 

N-0611 Oslo  0611 OSLO       

support.norway@omron.com   97/194 

 

4.2 Test av funksjoner med NS-panel 
 

4.2.1 Lage eit CX-Designer prosjekt for betjening av startaren 
 

Opne eit nytt prosjekt i CX-Designer: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Sett opp ethernetporten til Panelet slik: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Opprett ein Host for NJ: 

 

 

 

 

 

 

 

 

 

 

Slett denne 

Markèr 

Høgre-

klikk 
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Kopiere variablane frå Sysmac Studio til CX-Designer: 

 

Gå til «Global Variables» og endre Startar_1 til «Publish Only»: 

 

 

 

 

Dette vil gjere Startar_1 tilgjengeleg på Ethernet/IP. 

 

Ein kan no eksportere alle «Publish» variablane til CX-Designer. 

 

 

 

 

 

 

 

 

 

 

Desse vert no lagd i «clipbord», og kan limast rett inn i symbollista i CX-Designer: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Heile «Struct’en» er kome 

med. 

mailto:support.norway@omron.com


 
Postadresse:  Besøksadresse:  Telefon:   22 65 75 00  Foretaksregisteret: 

Postboks 109, Bryn Ole Deviks vei 6B Support:   23 17 39 40  NO 852 345 632 MVA 

N-0611 Oslo  0611 OSLO       

support.norway@omron.com   99/194 

 

Sett inn Start/Stopp knappar og 3 lamper for K1, K2 og K3: 

 

 

 

 

 

 

 

 

 

 

 

 

Gjenta for alle knappar/lamper, og lagre CX-Designer prosjektet. 

 

Gå til Sysmac Studio, og «Start NS integrated simulation»: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Last inn prosjektet i NS og test. 

 

4.3 Simulering av prosjektet 
 

 

Legg til Startar_1.YD_Delay og Startar_1.Running_FB i «Watch Window». 

Endre YD_Delay til 5s. 

 

 

 

 

 

 

 

 

 

 

Du kan no teste ved simulering at alt fungerer som det skal. 

For å sjekke «Hour_Counter» kan du sette «Running_FB» til true. 

 

 

 

 

 

 

 

 

Markèr 

«Dra» opp i 

adressefeltet. 
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Ta frem funksjonsblokka og WatchWindow og se kva som skjer når du trykker på knappene. 

 

 
Testbilde for NA 

 

 
 

 

 

 

 

 

 

 

 

 

Testbilde for NS 
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4.4 Legge til ein «Rung» for Homing til AX_Band og AX_Hjul 
 

(Dette kapittelet baserer seg på en ferdiglaget demo for NJ og NS) 

 

Last ned SuperUserTraining_Motion_U_Cam.smc til NJ, og NJ_Training_Servo.IPP til NS. 

I dette Sysmac Studio prosjektet er det ingen digital utgangsmodul, legg til denne før synkronisering. 

 

(Hugs å ta med parameter til servoforsterkarane ved synkronisering) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Legg inn f.eks som rung 5 under section Servo_Band: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gjer det same for AX_Hjul 

 

  

Ta vekk haken for også å synkronisere 

parameter til servo forsterkarane. 

Bruk «Power On» knappen i NS 

så aksen er klar til å køyre.  

Start_Homing er eit internt bit.   
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4.4.1 CAM Profil 
 

Lag en CAM profil som vist: 

 

4.4.2 Legg til Section «IsKremFylling» 
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4.4.3 Sett inn MC_CamIn: 
 

 

Dei interne variablane: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Vi må legge til ein verdi i «Start_Pos»: 

Sett inn ein «Rung» over MC_CamIn. (Lurt å sette verdien StartPos før FB vert utført) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Ved å sette «Initial Value», 

så slepp vi å programmere 

inn verdien. 

Høgre-

klikk 

CAM profil vert aktivert når AX_Band 

har gått 1 omdreining 

mailto:support.norway@omron.com


 
Postadresse:  Besøksadresse:  Telefon:   22 65 75 00  Foretaksregisteret: 

Postboks 109, Bryn Ole Deviks vei 6B Support:   23 17 39 40  NO 852 345 632 MVA 

N-0611 Oslo  0611 OSLO       

support.norway@omron.com   104/194 

 

4.4.4 Sett in MC_CamOut: 
 

 

 

 

 

 

 

 

 

 

 

 

 

4.4.5 Teste CAM Profil: 
 

Sett «Power On» på båe servoane: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

1. 
Sett hastighet 

2. 
Start Bandet 

3. 
Enable Cam 

mailto:support.norway@omron.com


 
Postadresse:  Besøksadresse:  Telefon:   22 65 75 00  Foretaksregisteret: 

Postboks 109, Bryn Ole Deviks vei 6B Support:   23 17 39 40  NO 852 345 632 MVA 

N-0611 Oslo  0611 OSLO       

support.norway@omron.com   105/194 

 

5 Tips og Triks 

5.1 Nullstilling og Reset 
 

Hvis alt går galt og du vil begynne på nytt finnes det et menyvalg for å tømme Controlleren for data. 

Gå Online og velg PROGRAM mode. Menyvalget «Controller/ClearAllMemory..» vil sette alt tilbake til 

«eskenytt». 

 

«Controller/ResetController…» vil restarte Controlleren som om du slo strømmen av/på. Program og data beholdes. 

5.2 Kompilering og programsjekk 
 

 
 

Check All Programs - Programmet blir kontrollert for feil. Eventuelle problemer blir rapportert i Build-vinduet. 

Her kan man klikke på linjene og hoppe til feilen i programmet. 

 

Build - Programmet blir kompilert. Eventuelle feil vil bli markert. Ved endringer blir bare endringene kompilert. 

 

Rebuild - Hele programmet blir kompilert. Eventuelle feil vil bli markert og rapportert i Build-vinduet. 

 

5.3 Monitorering 
 

En Tabell ARRAY[0..999] OF INT kan være unødvendig å monitorere i sin helhet. 

Man kan monitorere både Tabell[555] og Tabell[550-555]. Husk da å bruke Watch og ikke Watch(Table). 

 

 

Unngå å skrive [0 i en index som i linje 2. Monitoreringen vil feile. 

  

 
 

5.4 Kommunikasjon 
 

Hvis du mister kontakten med CPUen under en operasjon, kan det oppstå en «fil-låsing» i controlleren. For å slippe 

å slå strømmen av/på for å få kontakt, kan du velge «Controller/ReleaseAccessRights…». 

 

  

mailto:support.norway@omron.com


 
Postadresse:  Besøksadresse:  Telefon:   22 65 75 00  Foretaksregisteret: 

Postboks 109, Bryn Ole Deviks vei 6B Support:   23 17 39 40  NO 852 345 632 MVA 

N-0611 Oslo  0611 OSLO       

support.norway@omron.com   106/194 

 

5.5 Splittvindu med HMI og Controller 
 

Hvis man jobber med NA og Controlleren parallelt er det greit å ha både programmet og skjermbildene opp 

samtidig. Høyreklikk på en av vindusflikene og velg NewVerticalTabGroup. 

 

 
 

 
 

Med Drag&Drop av kontakter og utganger fra Ladder kan man også raskt lage ferdigadresserte knapper og lamper i 

bildet til skjermen. 
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5.6 Bruke NA til å endre tida på en Timer i NJ 
 

 

Her er et eksempel på hvordan en kan bruke et operatørpanel til å endre tida på en Timer i NJ. 

Variabelen Millisekunder legges inn som en DataEdit i NA. 
 

 
 

5.7 Synkronisere klokka i NA og en Sysmac Controller 

 
Klokka i Controlleren kan vi endre manuelt i menyen «Controller/ControllerClock…» i SysmacStudio.  

Klokka i NA kan vi endre via System-menyen i panelet eller via «HMI/HMIClock...» i SysmacStudio. 

 
Her er eksempler på hvordan en kan synkronisere klokkene i NA og NJ/NX1P. Det beste er å bruke NTP slik at 

klokkene blir synkronisert via en server på internett. Se eget kapittel om dette. Eksemplene kan typisk benyttes hvis 

man ikke har nettilgang. 

 

5.7.1 Endre klokka i Controlleren fra NA 
 

Vi kan for eksempel lage en knapp for å aktivere synkroniseringen: 

  
 
Vi lager en variabel NATime i Controlleren som vi kobler til klokkevariabelen i NA. 

  
 
Når knappen aktiveres, settes klokka i NJ lik NATime fra NA. 
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5.7.2 Endre klokka i NA fra Controlleren 

 
Dette er litt mer komplisert ettersom vi må lage et lite Script. 

 

Vi lager en variabel NJTime i NA som henter klokka fra Controlleren. 

 

 
Så lager vi en Subrutine på «klokkesida» for å synkronisere klokka når subrutinen kjøres. 

 
 
Til slutt lager vi en knapp på «klokkesida» som kjørere subrutinen som en Event-Action. 

 
 

5.7.3 Endre klokka i NA 

 
Denne prosessen er enda litt mer komplisert ettersom vi ikke kan benytte dataformatet DateAndTime direkte i NA. 

 

Her lager vi et DataDisplayobjekt i skjermen for å kunne endre på Dato og Tid. Variabelen kaller vi 

myLocalDateTime. 

 
 

Deretter lager vi en Subrutine på «klokkesida» for å endre på innholdet i DataDisplay-objektet. 
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Subrutinen kjører vi når vi klikker på DataDisplay-objektet. 

 
 

Ved å klikke på objektet i Runtime kommer følgende PopUp og vi kan gjøre endringer. 

 
 

Deretter må følgende Subrutine kjøres for å konvertere DateTime til Date_And_Time og oppdatere klokka i NA. 

(Les litt videre før du fyller inn denne subrutinen). 

 

 
 

Denne subrutinen refererer til funksjonen NADateTimeIAG0 som er en tilleggsfunksjon du må installere manuelt. 

 

Gå inn i følgende meny på SysmacStudio: 

  
…og installer filen “NADateTime.iag”. Denne filen kan du laste ned under Documents på 

 Support Norway Sharepoint. 

  

Dra og slipp IAG-objektet inn på den aktuelle siden. Det spiller ingen rolle hvor, fordi den blir usynlig når 

applikasjonen kjører. 
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Typisk vil objektet få navnet NADateTimeIAG0 som du nå kan kjøre i Subrutinen. Sjekk dette selv. 
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5.8 Bygge strukturer for å redusere antall Tags 
 

Under DataTypes kan man bygge strukturer på f.eks. knapper og lamper. Disse bygges deretter inn i en ny struktur, 

f.eks. sHMI. 

 

 
 

 

 

 

 

 

 

 

 

 

 

Til slutt lager man en Global variabel knyttet til sHMI. 

 
 

Nå har man en Tag som inneholder både knapper og lamper, og man slipper å lage nye tags i NA hver gang man 

lager en knapp eller lampe i PLS-programmet. sHMI kan selvfølgelig bygges ut til å inneholde samtlige data som 

skal overføres mellom NA og CPU. 

 

En liten ulempe med denne metoden er at man ikke kan endre på strukturen så lenge man er OnLine med PLSen. 
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5.9 Konverteringsproblemer 
 

PLSen er ganske nøye på riktig datatype. Ofte får man feilmelding av typen: 

 

The input parameter types cannot be converted to the output parameter types. 

Comparison, assignment, or operation is performed for different data types. 

 

Men ikke alltid.  

MOVE (INT) til (REAL) går fint men MOVE (REAL) til (INT) går ikke. 

ADD (INT) og (REAL) til (REAL) går fint det også. 

 

Pass også på at du ikke går i det klassiske Overflow-fella. Når en INT blir større enn 32767, skifter den til å bli et 

stort negativt tall. 

 

5.9.1 Noen konverteringer 
 

Her slår vi sammen 4 byte til en DWORD med PackDWord (PackWord finnes også) og deretter til en UDINT: 

 
EnUDINT:=(TO_UDINT(PackDword(HighHigh:=Data[20], HighLow:=Data[21], LowHigh:=Data[22], LowLow:=Data[23]))) 

 

 

Konvertering fra tall til tekst eller motsatt er en annen utfordring. 

 

Her er noen eksempler: 

 

1) 

Teksten er et WORDArray av ASCII-koder og vi må lage oss et ByteArray. Hvis det er et ByteArray, slipper viå 

bruke  FOR Loopen. Noen ganger kommer teksten omvendt i hvert WORD. Da kan vi bytte til _LOW_HIGH. 

 
FOR i:=0 TO 9 DO 

 ToAryByte(WORDArray[i],_HIGH_LOW ,ByteArray[i*2]); 
END_FOR; 

Teksten:= AryToString(ByteArray[0],20);  

 
eller slik 

 

AryByteTo(ByteArray[0],20,_HIGH_LOW ,Teksten); 
 

2) 

Her lager vi en IP-adresse som en tekst fra et IntegerArray: 

 
IPAddress_string:=CONCAT(UINT_TO_STRING(IPAddress_num[0]) ,'.', UINT_TO_STRING(IPAddress_num[1]) ,'.'); 

IPAddress_string:=CONCAT(IPAddress_string,  UINT_TO_STRING(IPAddress_num[2]) ,'.', UINT_TO_STRING(IPAddress_num[3])); 

 
3) 

Her slår vi sammen 4 byte til en DWORD og deretter til en UDINT: 

 
EnUDINT:=(TO_UDINT(PackDword(HighHigh:=Data[20], highLow:=Data[21], LowHigh:=Data[22], LowLow:=Data[23]))) 
4) 

En INTeger kan gjøres om til en tekst med: 

 
Teksten:=INT_TO_STRING(INTegeren); 
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6 Smarte funksjonsblokker 
 

For å gjøre programmeringen raskere har vi i Omron Norge laget en del nyttige funksjonsblokker. Disse har ikke 

gjennomgått Omron strenge testkrav, så vi kan ikke gå god for at de er helt feilfrie. Bruk dem gjerne i programmene 

dine og gi oss beskjed hvis du skulle oppdage en feil eller har ønsker om forandringer. 

 

Her følger en kort beskrivelse av funksjonsblokkene. Legg merke til at de fleste av disse funksjonene og 

funksjonsblokkene ligger i egne mapper (Namespace) under \\OEN\. 

Beskrivelsen er sortert alfabetisk på blokkenes navn med versjonsnummer bak. Blokkene justeres og bugfikses 

kontinuerlig, så en må regne med å måtte korrigere eget program ved oppdatering til nytt Library. 

 

Funksjonsblokker må ha egne navn når du bruker dem i programmet. Funksjoner skal ikke ha det. Begynn gjerne 

med FB i navnet slik at du skiller dem fra andre variabelnavn. 

 

Det er ellers også tatt med noen funksjonsblokker fra standardbiblioteket for å vise eksempel på bruk av disse. 

 

Libraries har følgende Namespace for sine strukturer. Legg merke til at alle 

begynner med n. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Funksjonsblokkene kan du laste ned fra vår Sharepoint: 

 

www.Omron.me/support_norway 

 

Send en e-post til support.norway@omron.com hvis du ikke har tilgang, så skal vi sende deg link til pålogging. 

 

 

 

 

 

 

 

 

Oppdatering av beskrivelse for funksjonsblokker har blitt flyttet til 

egne manualer på engelsk. Kapittel 6 i kurskompendiet vil derfor 

være noe ufullstendig. 
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6.1 OEN_BaseBlocks 

6.1.1 Alarms 3.0.0 
 

Dette er en funksjonsblokk for å systematisere alarmer i CPUen. Den bruker et Alarm-array for å holde oversikt 

over status på alarmene. Samme array benyttes til å bestemme forsinkelse, grenseverdier, og utkobling. Se mer om 

dette i tabellen nedenfor. Alarm-arrayet kobler du enkelt til alarmfunksjonen i NA. 

 

Den kan håndtere flere hundre alarmer i en loop. 

 

 
 

Alarm - Global strukturvariabel som inneholder alle data for alarmene 

ACK_All - Kvittere alle aktive alarmer. Sett denne TRUE for å Autokvittere. 

Reset_All_Counters - Nullstiller alle tellere for alle alarmer 

Username - Navnet til den som kvitterer alarmen 

 

Følgende variabler er tilgjengelig i Alarmtabellen: 

 

TABLE INPUTS  
DISSE MÅ AKTIVERES FRA PROGRAM  

 

AnalogInput Analog value to observe (Use either Analog or Digital) 

DigitalInput (0) Digital input to observe (Use either Analog or Digital) 
Disabled (15) Alarm disabled/Not in use 
ACK Ackowledge 
Reset_Counter Reset of alarm counter 
ACK_Username Name of user that ACKed 

 

TABLE OUTPUTS 
DISSE VISER STATUS PÅ ALARMENE 

 

ActiveNoACK (8) Alarm is active and not ACKed from ACK            (ON until ACK) 

NormalNoACK (10) Signal is back to Normal but Alarm not ACKed 
ActiveAndACK (9) Alarm is ACKed but still active 
DigitalAlarm (1) The alarm is from a Digital Input 
GroupDigital_Alarm (12) DigitalAlarm with OFF_ON Delayed Trigger for each alarm 

HighHigh_Alarm (4) AnalogInput >= HighHigh Analog Level. Delayed. 
High_Alarm (5) AnalogInput >= High Analog Level. Delayed. 
Low_Alarm (6) AnalogInput <= Low Analog Level. Delayed. 
LowLow_Alarm (7) AnalogInput <=LowLow Analog Level. Delayed 
Counter Counting number of alarm occurences 
Alarm_TimeStamp When alarm was set 
CriticalAlarm_TimeStamp When HighHigh or LowLow was set 
ACK_TimeStamp When ACKed 
Inactive_TimeStamp When signal went back to Normal 
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Status Collection of alarm status signals. See bitno in ( ) in this table 

 

 

TABLE SETTINGS 
DISSE MÅ LEGGES INN I TABELLEN 

 

ShortName Text to identify alarm 

Group Group number (1-99) when using GroupAlarms Function 

HighHigh_Limit HighHigh Analog Level. 
High_Limit High Analog Level 
Low_Limit Low Analog Level 
LowLow_Limit LowLow Analog Level 
Delay Delay before setting alarm 

 

Slik ser tabellen ut i Sysmac Studio: 

 

 
 

Her er et eksempel på oppsett i NA for å få opp alarmtekster, og for å kvittere alarmen i PLSen når alarmen blir 

kvittert på skjermen: 

 
Alarm-array i dette eksemplet er altså RO_Alarm. 

 

Alarmene konfigureres slik i PLSen: 

 
 

Analoge alarmer kan for eksempel legges inn på denne måten: 
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Da slipper man å lage separate alarmer for alle 4 alarmnivå slik som i eksemplet med digitale alarmer. 

 

Den grønne kommentarteksten på alarmene kan du legge inn via Comment i External Variable List: 

 
Eller ved å klikke under utgangen i Ladder.  

 

Alarmstatus henter du ut fra Alarmstrukturen og direkte i NA, eller for visning i Ladder: 

 
 

I NA vil det nå bare være en variabel på variabellista å forholde seg til. Ryddig og enkelt. 

 

6.1.2 GroupAlarms 2.0.0 
 

Denne blokka brukes i kombinasjon med OEN\General\Alarms. I Alarms-tabellen legger man på forhånd inn 

hvilken gruppe alarmen tilhører. En kan ha mange alarmer i hver gruppe. Det anbefales å samle single alarmer som 

tilhører samme gruppe i nummerrekkefølge. Gruppenummeret refererer til Alarm[1] opp til Alarm[99]. Ved bruk av 

gruppealarmer er dermed Alarm[1-99] reservert. Alarmer som skal inn i grupper må ha nummer fra Alarm[101 -

>].Gruppealarmer har en egen GroupDigital_Alarm. Den aktiveres ved en singelalarm i gruppen, men har den 

egenskapen at den går av i en periode definert i Delay på gruppealarmen. På den måten får man en gruppetrigger for 

hver ny alarm i gruppen. Se grafikken nedenfor. 

 

 
 

Alarm[1] er en gruppealarm, og Alarm[101] og [102] er lagt inn i gruppe 1. 

 
Legg merke til forskjellen mellom Digital_Alarm og GroupDigital_Alarm for gruppe 1. 
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6.1.3 AnaScaling 2.5.0 
 

En funksjon for skalering av analoge signaler. Den kan brukes både for innganger og utganger. En kan velge om en 

vil bruke AnalogData.In (REAL) eller In_INT samt AnalogData.Out(REAL), Out_INT eller Out_REAL. 

 

En kan også velge å bruke AnalogType som finner rett oppløsning automatisk, eller legge inn modulens oppløsning 

manuelt med AnalogData.Out.Min/Max eller AnalogData.In.Min/Max. Med FilterFactor kan en jevne ut signalet 

gjennom et IIR Lavpassfilter. FilterFactor er i ms og i forhold til scantid. 

 

   
 

Funksjonen MovingAverage ligger i SysmacStudio Library og kan også brukes til å jevne ut signalet. Se Help eller 

Manualen. 

Følgende datastruktur er opprettet for bruk sammen med AnaScaling. 

 
  

mailto:support.norway@omron.com


 
Postadresse:  Besøksadresse:  Telefon:   22 65 75 00  Foretaksregisteret: 

Postboks 109, Bryn Ole Deviks vei 6B Support:   23 17 39 40  NO 852 345 632 MVA 

N-0611 Oslo  0611 OSLO       

support.norway@omron.com   118/194 

 

6.1.4 ASCIItoHEX 1.0.0 
 

En funksjon som konverterer en tekst til en HEX-string og ByteArray av ASCII-koder. Samtidig får man også antall 

HEX-koder(byte) i disse to. Dette er ikke det samme som antall karakterer i teksten, ettersom mange spesialtegn gir 

flere byte. (Se ASCIItabeller på UTF8). Sørg for at ByteArray er minst 256 bytes ettersom ASCIIstring er definert 

til dette. 

 

 
 

 

6.1.5 BinSelect 1.0.0 
 

En funksjon som sender status på den ene av to innganger ut på utgangen ved hjelp av en tredje inngang. Hvis 

Z=FALSE blir utgangen lik x, hvis Z=TRUE blir utgangen lik y. 

 

6.1.6 BitControl 2.0.0 
 

En multifunksjonsblokk med 3 utganger. 

 

Når Input går på: 

Output forsinkes på med ONDelay. 

Toggle forsinkes på med ONDelay. 

OneShot forsinkes på med ONDelay men går av etter OFFDelay. 

 

Når Input går av: 

Output forsinkes av med OFFDelay. 

Toggle forblir på til Input går på neste gang. 
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6.1.7 BitDataMonitor 1.0.0 
 

En enkel funksjon for å samle bit i programmet for å få bedre oversikt. 

 

 
 

6.1.8 BOOL_To_UINT 1.0.0 
 

Konvertering av et bit til heltallsverdien 1 eller 0. 

 

6.1.9 UINT_To_BOOL 1.0.0 
 

Konvertering av heltallsverdien 1 eller 0 til et bit. 

 

 
 

6.1.10 CountDownTimer 1.0.0 
 

En timer som teller ned fra en bestemt verdi så lenge Enable er aktiv. Verdien beholdes ved strømbrudd. 

TimeLeft resettes automatisk når Enable går på og TimeLeft=0. 
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6.1.11 CPU_System 1.3.1 
 

Ei funksjonsbokk som viser systeminformasjon. CPUSystem samler alt i en datastruktur. 

 

 
 
  

mailto:support.norway@omron.com


 
Postadresse:  Besøksadresse:  Telefon:   22 65 75 00  Foretaksregisteret: 

Postboks 109, Bryn Ole Deviks vei 6B Support:   23 17 39 40  NO 852 345 632 MVA 

N-0611 Oslo  0611 OSLO       

support.norway@omron.com   121/194 

 

6.1.12 DateAndTime 1.0.0 
 

Denne funksjonen gir deg en datastruktur som inneholder tidspunktet i øyeblikket. I tillegg både skuddår, 

ukenummer, årets dag og antall sekunder som har gått siden 1.januar 1970! (Kjekt å vite). 

 

  
 

 
Today bruker en predefinert datastruktur. Det ser vi fordi den begynner med _s. 

 

6.1.13 DevicePort_Setup 1.2.0 
 

DevicePort_Setup forenkler oppsettet for funksjonsblokker som bruker serielle porter. 

 

 
 
SerialBoard_ID eller NX_CIF_Unit_ID lager du i IOMap ved å høyreklikke på modulen og velger 

«DisplayNodeLocationPort». 

 

NX_CIF_Port brukes bare når du skal kommunisere via NX-CIFxxx, og portnummer er 1 eller 2. 

 

Husk å konfigurere porten med protokoll, baud, paritet og stop-bit. 
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6.1.14 DST_TimeChange 
 

Ei funksjonsblokk for sommertid. Legg merke til at inngangen skal være basert på UTC, typisk fra en NTP-Server. 

 

 
 

6.1.15 EC_Control 3.1.0 
 

Med denne funksjonsblokka kan du resette EtherCAT-nettverket ved feil, samt koble noder ut og inn av loopen. 

Utgangen EtherCAT er en datastruktur hvor du kan lese av status for opptil 192 noder. 
 

  
 
Aktiviser AutoReset hvis du ønsker å resette feil på nettverket automatisk når slaver faller ut og kobles inn igjen. 

Sett DisconnectSlave til et nodenummer og noden vil bli frakoblet umiddelbart. EtherCAT.CTRL.DisconnectSlave 

blir automatisk satt til 0 når slaven er frakoblet. Frakoblede slaver kan kobles ifra nettverket uten å gi feilmelding. 

Sett ReconnectSlave til et nodenummer og noden vil bli tilkoblet umiddelbart. EtherCAT.CTRL.ReconnectSlave 

blir automatisk satt til 0 når slaven er tilkoblet. 

Med en puls på Reset kan du resette feil manuelt hvis du ikke ønsker å bruke AutoReset. 

 

AutoResetCountOut angir at valgt antall reset er oppnådd uten at feilen har blitt resatt. Resettintervallet er 1s. 

EtherCAT.CTRL.AutoresetCount kan settes til en valgt verdi hvis en ikke ønsker å bruke UINT#3. 

EtherCAT.CTRL.AutoresetDelay kan settes til en valgt verdi hvis en ikke ønsker å bruke TIME#1s. 

Disconnected viser hvor mange noder som er satt i StandBy. 

Available viser hvor mange noder som er Online+OnlineStandBy. 

ErrorLevel og ErrorCode hentes fra standardfunksjonen GetECError 
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6.1.16 EIP_Control 2.0.0 
 

Blokka viser status på EIP-kommunikasjonen i en datastruktur. Registered,  Communicates og NodesInError  viser 

antall noder som er definert, som kommuniserer og som har feilstatus. 

 

6.1.17 FahrenheitToCelsius 1.0.0 
 

Konvertering av grader Fahrenheit til Celsius. 
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6.1.18 FIFOStack 1.0.0 
 

Enkel datalogging hvor tabellen «Stack» (Array[0..99] of REAL) lagrer de «Size» siste «Value». Dette kan vises 

som en flytende kurve i BrokenLineGraph i NA.  

 

 
 

 
 
Mapping i NA: 

 
 
Som gir to globale variabler: 

 
 
Så lager vi en Data Group med to variabler koblet til disse: 
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Til slutt lager vi BrokenLineGraph av DataGroup: 

 

 
 
 
 

 
 

6.1.19 GroupTrigger 1.0.0 
 

Ei funksjonsblokk som ser på endring på inngangene.  

Hvis en av dem endres fra AV->PÅ vil dette resultere i en puls på DIFU. 

Hvis en av dem endres fra PÅ->AV vil dette resultere i en puls på DIFD. 

Pulslengden bestemmes av DIFTime. 

Antall signaler som er på vil en kunne lese av på SignalsON. Hvis SignalsON>0 får du utgang på SignalON. 
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6.1.20 HasChanged 1.1.0 
 

Ei funksjonsblokk som gir en puls ut hvis verdien på inngangen endrer seg. En kan velge å bruke en av de tre 

inngangene eller alle. 

 

 

6.1.21 InchTomm 1.0.0 
 

Konvertering av tommer til mm  
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6.1.22 JoyStick_Control 1.0.1 
 

Med denne funksjonen kan du splitte opp et analogsignal i to like deler slik at du kan kjøre opp/ned eller 

frem/tilbake. 

 

Med ZeroSpan legger du en prosentverdi som tilsvarerer bevegelse rundt midtpunktet på Joystick som ikke skal gi 

utgang. 

Med BreakPoint kan du bestemme hvor mye utgangen skal gi i % når Joystick har 50% pådrag. 

 

Med Calibrate kan du lære inn Joystick sitt nullpunkt, maxpunkt og minpunkt.  

 

1) Sett Joystick i senter. 

2) Aktiver Calibrate 

3) Flytt Joystick til Max 

4) Flytt Joystick til Min 

5) Slipp Joystick 

6) Slå av Calibrate  

 

  

  
Dette er datastrukturen som er laget for denne funksjonen. 
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6.1.23 Loop 1.1.0 
 

En funksjon som løper mellom MinValue og MaxValue for hvert scan inngangen er aktiv.  

 
 

6.1.24 LowPassFilter_IIR 1.0.0 
 

Lavpassfilter for å jevne ut analoge signaler. 

 
 

6.1.25 MeanMaxMin 1.0.0 
 

En funksjonsblokk for å finne gjennomsnitt, maxverdi, minverdi og standardavvik av tallene i en tabell.  

 

 
 

Trigger legger InputData (REAL) inn i FIFO-tabellen DataTable. DataTable kan være så stor man ønsker. 

Reset nullstiller hele tabellen. 

NumOfValues er antall verdier i tabellen man ønsker å bruke ved beregningen. 
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6.1.26 MovingHolidays 2.0.0 
 

Med denne funksjonen kan du få dato for bevegelige helligdager som WORD eller _sDT datatype. Velg aktuelt år 

på Year. Du kan velge MMDD eller DDMM-format med inngangen DDMM. 

Variabelen MovingHolidaysDT inneholder alle disse dagene som en _sDT-struktur. Den kan være nyttig sammen 

med andre funksjonsblokker. 

 

 
 

6.1.27 NX_ECC_Status 1.0.0 
 

Ei funksjonsblokk for å få bedre oversikt over statusbit på en NX-ECC-node. Alt samles i strukturen NX_Status for 

lettere håndtering videre. 
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6.1.28 NX_ModbusRtuRead 
 

Ei funksjonsblokk i standardbiblioteket for å lese serielle modbusdata fra en slave. 

Eksemplet nedenfor viser en NX1P2 med optionkort som leser 9 Modbus Holdingregister 1001-1010 fra 

slavenummer 1. ReadDat vil typisk være et WORD-Array på minimum 9 elementer. 

 

 
 

Legg merke til OP1_Node_location_information som du må generere via IOMap med DisplayNodeLocationPort 

på høyreklikkmenyen. 

 

 
 

Eksempel på lesing av data fra E5DC temperaturregulator med NX1P og NX1W-CIF11 OptionBoard: 
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6.1.29 NX_RS1201 2.0.0 
 

Forenkler bruk av NX-modulen RS1201 for veieceller. Bruk strukturen Loadcell til konfigurering og styring. 

 
 

6.1.30 NX_SendSMS 1.0.0 
 

Ei enkel funksjonsblokk for å sende SMS til et telefonnummer via en serieport og et modem. 

 
 

6.1.31 OS32C_DM 1.0.0 (BETATEST pågår) 
Lesing av data fra sikkerhetsscanner OS32C-DM via EthernetIP.  

 

 

6.1.32 OunceToGrams 1.0.0 
 

Konvertering av unser til gram. 
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6.1.33 PRM21_Control 0.99.0 
 

Styring og overvåking av Profibus Master CJ1W-PRM21 i NJ. 

 

 
 

Lag variabler som passer til Default Setup på denne måten: 

 
 

 
 

Se mer informasjon i Tips!Profibus på NJ.pdf 

6.1.34 psiTobar 1.0.0 
 

Konvertering av psi til bar.  
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6.1.35 PulseConverter 1.6.0 
 

Denne blokka konverterer pulser til enheter/tidsenhet og total mengde. Typisk brukt for flowmeter og energimåling. 

Totalen kan presettes til en valgt verdi og Batch kan nullstilles. Alle data kan monitoreres i Meter-strukturen. Legg 

merke til pilen på PulseInput som indikerer flankebasert inngang. 

 

 

 

 

 

 

 
  

6.1.36 PulseGenerator 1.1.0 
 

Utgangen gir 50/50 pulser med en angitt frekvens. Vær obs på at PLSens CycleTime vil påvirke nøyaktigheten på 

frekvensen. 
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6.1.37 PWM 1.0.0 
 

Ei funksjonsblokk for Pulsbreddemodulert utgang. Duty angis i % og bestemmer hvor stor andel av CycleTime 

Output skal være på. Ved å sette CycleTime til lave verdier kan utgangen brukes til dimming av lys. En CycleTime 

som nærmer seg PLSens CycleTime vil gi dårlig oppløsning/unøyaktighet.  

 

  
 
10Hz med PLS CycleTime 4ms: 

 
 

 

6.1.38 Read_IPAddress 1.0.0 
 

Denne funksjonsblokka gir deg IP-adressen til NJ. Blokka er for øvrig laget av en fransk kollega. 

 

 
 

6.1.39 RealTo 1.0.0 
 

Ei funksjonsblokk som konverterer en REAL til 2 WORD. 
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6.1.40 SCU_PortSetup 0.1.0 
 

Ei funksjonsblokk for å forenkle oppsettet av en SCU-port. 

Baudrate har følgende alternativ: 9600, 19200, 38400, 57600, 115200 eller 230400. 

Legg merke til at Format må angis som en String. 8N1, 8E1, 7E1 eller 7E2. 

StartCode er Default. 

EndCode er satt til <CR><LF>. 

 

Alle de 4 utgangene på blokka må kobles til SCU-modulens variabler i IOMap. 
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6.1.41 SDLogging10Col 1.0.1 
 

Denne funksjonsblokka lager en fil på SD Minnekort i CPUen. Se også TableLogging10Col. 
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6.1.42 Sequencer 1.0.0 
Ei blokk som kan brukes til å kjøre sekvenser. 

 

 
 

StepNext inkrementerer StepAktive og gir en puls på Trigger. Pulsen kan forsinkes med TriggerDelay. 

Reset setter StepActive=0. 

NumberOfSteps definerer antall step før StepActive går tilbake til 1. 

TimeOutTime aktiverer StepNext når tida har gått ut. Må være minst 1ms for å fungere. 
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6.1.43 Stack_Integers 1.1.0 og  

6.1.44 Stack_Reals 
En funksjonsblokk for å lagre, sortere og filtrere integer/real data. 

 

 
 

Stack  - Tabellen for dataene 

Size – Antall verdier man ønsker å ha plass til i tabellen 

Enable – Aktiverer funksjonen 

LIFO_FIFO – =TRUE vil ta nederste verdien ut av tabellen med Get 

Value – Verdien som legges nederst i tabellen med Put 

Put – Legger Value inn i tabellen 

Get – Fjerner øverste eller nederste verdi fra tabellen og legger den på Value_Out 

RemoveValue – Fjerner alle verdier som er lik Value fra tabellen  

SortLowToHigh – Sorterer hele tabellen i stigende rekkefølge 

SortHighToLow – Sorterer hele tabellen i synkende rekkefølge 

EmptyStack – Setter alle verdier i tabellen til 0 

ENO  =Enable 

Value_Out – Verdien som plukkes ut av tabellen med Get 

ValuesInStack – Antall verdier som ligger lagret i tabellen 

6.1.45 SummationCounter 1.1.0 
 

Ei funksjonsblokk som kan brukes til overvåking av driftstimer. Verdiene beholdes ved strømbrudd. 

 
 

6.1.46 SunsetAndSunrise 1.0.0 
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Ei funksjonsblokk som gir deg tidspunkt for soloppgang, solnedgang og når sola er høyest på himmelen.

 
 

CurrentDay kan du få fra Funksjonen DateAndTime. Long og Lat for din lokasjon finner du på nettsiden: 

 

http://www.esrl.noaa.gov/gmd/grad/solcalc/ 
 

Her kan du sjekke om resultatet fra funksjonsblokka stemmer også. 

 

På UTC_Offset angir du antall timer ifra GreenwichMeanTime. +1 er bl.a. for Norge. 
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6.1.47 Swap4Bytes 1.0.0 
 

En FB for å bytte om på bytes og words. Denne er nyttig ved datakommunikasjon hvor bytene ikke kommer i ønsket 

rekkefølge. Dette er relativt vanlig for Profibus, CAN og Modbus. 

 

eSwap#Bytes bytter om på 2 og 2 byte. ABCD blir BADC 

eSwap#Words bytter de to første bytene med de to siste. ABCD blir CDAB. 

eSwap#BytesAndWords gjør begge deler. ABCD blir DCBA. 

 

Velg bare en av de 4 inngangene fordi resultatet av denne ene blir gitt på alle 4 utgangene. 
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6.1.48 TimeDateSwitch 1.0.0 
En multikanals FB for å starte og stoppe hendelser basert på valgte perioder. Valgfritt antall kriterier og kanaler. 

 

 
 

I TimeDateArray legger du inn tidspunkt for Start og Stopp(End), hvilken kanal som skal styres og om kanalen skal 

styres av eller på i dette tidsintervallet. Antall rader i dette Array bestemmer du selv. Begynn med rad 0. 

Channel er også et Array med valgfri størrelse. Du bør ikke bruke Channel 0, det kan lett bli rot. 

Inndelingen kan være fast dag i året, fra en dag til en annen dag, mellom to klokkeslett, på valgte ukedager mm.  

Programmet baserer seg på tidspunkt fra-og-med Start til-og-med End.  

Tabellen nedenfor forklarer dette med noen eksempel. 

 

Første rad er Start-tidspunkt. Andre rad er Stopp-tidspunkt. 

[0] 

År Mnd Dag Time Min Kanal Ukedag Kanal Av Beskrivelse 

0 5 17 0 0 1 0 0 0 0 0 0 0 TRUE Kanal 1 PowerOff=på hele dagen 

0 5 18 0 0     

[1] 

År Mnd Dag Time Min Kanal Ukedag Kanal Av Beskrivelse 

2020 7 1 0 0 2 0 0 0 0 0 0 0 TRUE Kanal 2 PowerOff=på hele ferien 

2020 7 21 23 59     

[2] 

År Mnd Dag Time Min Kanal Ukedag Kanal Av Beskrivelse 

0 0 0 08 0 3 1 1 1 1 1 0 0 FALSE Kanal 3 PowerOn=på i  

0 0 0 16 0    arbeidstida 

[3] 

År Mnd Dag Time Min Kanal Ukedag Kanal Av Beskrivelse 

0 0 0 10 0 3 0 0 0 0 0 1 0 FALSE Kanal 3 PowerOn=på på lørdager 

0 0 0 14 0     

 

Hvis vi ser på ferien 2020 som et eksempel vil man normalt legge inn ferien via et HMI. Variabelen TimeDateArray 

må da lages som en GlobalVariable Retain og et Array med en viss størrelse. 

Ferien ligger her i rubrikk [1] i eksemplet over, som da tilsvarer TimeDateArray[1]. 

 

Det må lages DataInput-felt i HMI som kobles til TimeDateArray[1].Start.Year, TimeDateArray[1].End.Year osv. 

Hvilken kanal som skal styres med dette kriteriet velges i TimeDateArray[1].Channel. 

For ferien ønsker vi å overstyre alle PÅ-kriterier og setter TimeDateArray[1].ChannelOff=TRUE, gjerne med en 

klikkboks i HMI. 

Ukedager er uvesentlig i ferien, men en klikkboks koblet til TimeDateArray[2].Weekday[1] vil tilsvare mandag som 

vist i rubrikk [2].  

Hver linje i TimeDateArray styrer altså kanaler. Disse kanalene kan for eksempel kobles til lys og/eller varme i rom. 

Channel[3].PowerOn er en BOOL som kan styre lyset på kontorene i arbeidstida. 

Legg merke til at rubrikk [2] og [3] styrer samme kanal, men med forskjellige tidspunkt og dager. 

17.mai som i rubrikk [0] kan man legge som fast kode i PLSen. Den vil da gjelde alle år. 

 

TimeDateArray[0].Start.Mnd:=5; 

TimeDateArray[0].Start.day:=17; 

TimeDateArray[0].End.Mnd:=5; 

TimeDateArray[0].End.Day:=18; 

TimeDateArray[0].Channel:=1; 

TimeDateArray[0].ChannelOff:=TRUE; 

 

I stedet for 18 på End.Day kan man jo også sette 17 på End.Day, 23 på End. Hour og 59 på End.Min.Da vil kriteriet 

være aktivt 1 min kortere tid. 
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Slik kan vi sørge for at lyset ikke går på i påskene de neste årene: 
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6.1.49 TCP_Messaging 1.1.0 
En FB for å sende egendefinerte data over TCP. 

 

 
 

 

Setup – Konfigurering av kommunikasjon mot TCP Server. Se utklipp ovenfor. 

Trigger – Signal for å sende Message 

Message – Datastring som sendes ut på porten med Trigger 

Busy – Overføring pågår, venter på svar 

Error – Feil ved sending 

ErrorID – Feilkode 

ReplyAsBytes – Bytearray som inneholder data mottatt fra server 
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6.1.50 Table_Logging10Col 1.0.1 
 

Ei funksjonsblokk som logger 10 kolonner i 10 rader. I kombinasjon med SDLgging10Col kan du lagre dette som en 

csv-fil på et minnekort i NJ. 
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6.1.51 Tank_Volume 2.2.0 
Beregning av væskemengde i en stående eller liggende tank basert på nivåmåling. 

 

 
 

Man kan velge mellom 6 typer tanker: 

 
 

Level er nivået i tanken i mm 

CylinderLength er lengden på den sylindriske delen av tanken i mm 

TotalLength er tankens fulle lengde i mm 

 

Resultatet gis i liter og prosent. 

6.1.52 TimeToTIME 2.0.0 
 

Konvertering av timer/minutter/sekunder til datatype TIME eller motsatt. Kan brukes for å sette tiden på en Timer i 

CPUen fra et felt i et operatørpanel med datatype UINT eller REAL. 

h_total viser TIME som en REAL.  
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6.1.53 TCP_Connect 1.2.0 
 

En funksjonsblokk for å forenkle kommunikasjon via SocketService. Open, Close, ClearBuf og GetTCPStatus er 

brukt i denne, og inngangen Open kan brukes for å åpne/lukke en Socket. F.eks. ModbusTCP kan deretter kjøres via 

angitt Socket. Setter du LocalPort=0 vil den finne en ledig port automatisk. 

 
 

En socket kan man se på som en slags serieport. Man åpner en socket og så sender man og mottar data på denne. 

CPUen kan ha mange sockets åpne på samme fysiske ethernetport, dermed er dette mye mer rasjonelt enn før, hvor 

man ofte måtte ha en serieport for hver enhet man skulle kommunisere med. 

 

6.1.54 Tx4bitTo4bit 1.0.0 
 

En funksjon for å koble fysiske innganger til interne bit. Legg merke til at en kan invertere inngangen ved å sette en 

o på pinnen. (Toggle Negate) 

 
 

6.1.55 Tx6bitTo6bit 1.0.0 
Samme som blokka over, men med 6bit for tilpasning til NX1P2-24 som har 14 innganger. 

 

6.1.56 Tx8bitTo8bit 1.0.0 
Samme som blokka over, men med 8bit for tilpasning til NX1P2-24 som har 14 innganger. 
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6.1.57 TxByteTo8bit 2.0.0 
 

Samme prinsipp som for Tx4bitTo4bit  men her mapper vi 8 bit direkte. Med Invert_Mask kan vi samtidig velge 

hvilke bit vi ønsker å invertere. For eksempel med Invert_Mask=0F (=0000 1111) vil bit 0-3 bli invertert. 

 

 

6.1.58 TxWORDTo16bit 2.0.0 
 

Samme som for TxByteTo8bit, men med 16 innganger. 

6.1.59 TxDWORDTo32bit 2.0.0 
 

Samme som for TxByteTo8bit, men med 32 innganger. 

 

6.1.60 Tx8bitToByte 1.0.0 
 

Her mapper vi 8 bit over på 8 fysiske utganger på samme modul. 

 

6.1.61 Tx16bitToWORD 1.0.0 
 

Samme som for Tx8bitToByte, men med 16 utganger. 

6.1.62 Tx32bitToDWORD 1.0.0 
 

Samme som for Tx8bitToByte, men med 32 utganger. 
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6.1.63 USGallonsToLiters 1.0.0 
 

Kovertering av USGallons til liter. 

 

6.1.64 ValueSelect 1.0.0 
 

En funksjon hvor du kan velge en av 5 verdier. 

Select kan være et tall mellom 1 og 5, og utgangen vil settes lik den valgte inngangen. 

 

 
 

6.1.65 WORDsTo 2.1.0 
Slå sammen to WORD-variabler til en REAL, DINT, eller et BYTE-array. Rekkefølgen på bytes i BYTE-array 

bestemmes av LSB_First (TRUE/FALSE).  

 

 

 
 

6.1.66 WORDsToDINT 1.0.0 
 

Slå sammen to WORD-variabler til en DINT. 
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6.1.67 ZoneCheck 1.0.0 
 

En funksjon som ser om en analog verdi er innenfor intervallet Value+OffsetHigh og Value-OffsetLow. 

Deviation viser avviket mellom Input og Value. 
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6.2 OEN_Acti9_Smartlink 
 

Dette er et Library som krever at OEN_BaseBlocks og MTCP_NJNX også er installert. 

6.2.1 Acti9 SmartLink 1.0.0 
 

Funksjonsblokk for å lese data fra Schneiders SmartLinksystem via ModbusTCP. 

 

  
Data fra hver PowerTag ligger i SmartLinkvariabelen. Legg inn IP-adressen til SmartLink-konsentratoren og aktiver 

Connect for å opprette forbindelse mellom konsentratoren og PLSen. Deretter vil du kunne monitorere data fra 

opptil 20 PowerTags. 

Hvis du setter Disable på PowerTags i SmartLink-strukturen som ikke er tilkoblet, vil du oppnå høyere 

oppdateringsfrekvens. 
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6.3 OEN_Drives 
 

6.3.1 MX2_Control 1.1.0 
 

Denne funksjonen kan brukes sammen med MX_Mapping for å forenkle styring av MX2 frekvensomformer via 

EtherCAT. MX2_Mapping.pdf for mer utfyllende beskrivelse. 

 
 

6.3.2 MX2_MappingAdv 3.1.0 
 

Denne funksjonsblokka brukes sammen med MX_Control for å styre MX2 frekvensomformer via EtherCAT. Det er 

laget egen dokumentasjon på hvordan du gjør dette. Se MX2_Mapping.pdf for mer utfyllende beskrivelse. 

 

 
 

Navnet på MX2 definerer du her: 

 
 

Deretter Autogenerer diu variabler i I/O Map 
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6.3.3 MX2_MappingStd 3.1.0 
 

Denne funksjonsblokka brukes sammen med MX_Control for å styre MX2 frekvensomformer via EtherCAT. Det er 

laget egen dokumentasjon på hvordan du gjør dette. Se MX2_Mapping.pdf for mer utfyllende beskrivelse. 

 

 
 

 

 

6.3.4 Q2x_MappingStd 1.0.0 
 

og 

6.3.5 Q2x_Control 1.0.0 
 

Q2x_MappingStd brukes sammen med Q2x_Control for å styre Q2A og Q2V frekvensomformer via EtherCAT. For 

at omformeren skal kunne styres via EtherCAT må b1-01=3 og b1-02=3 settes i omformeren. I tillegg må du legge 

inn en adresse på omformeren i EtherCAT-nettverket. Denne står normalt til 0. 

 

1) Før du begynner må ESI-filen Omron Q2A_Q2V_1000_ECT_2_02_Rev_01.xml legges i ESI-mappa til 

SysmacStudio. Her:  

C:\Program Files (x86)\OMRON\Sysmac Studio\IODeviceProfiles\EsiFiles\UserEsiFiles 

 

2) Deretter legger du til omformeren på EtherCAT på vanlig måte slik det er beskrevet i kurskompendiet. 

(Compare and Merge….) 

 

3) Så endrer du adressen til et ledig nummer med WriteSlaveNodeAddress. Q2A/Q2V må restartes nå. 

 
 

4) Du må også redigere PDO Mapping så det ser slik ut. 

 
5) Deretter genererer du variabelnavn i IOMap. 

 

6) Så legger du blokkene inn i programmet og fyller ut som vist i eksemplet under her. 
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6.3.6 SX_EINT_TO_REAL 1.1.0 
 

En funksjonsblokk for å konvertere SX-omformerens Eint-format til Real. SX har mange variabler basert på Eint. 

Dette er en 16bit blanding av flyttall og integer hvor bit15 bestemmer formatet.  

 

 
 

6.3.7 SX_Control 2.1.0 
 

Denne funksjonen brukes sammen med SX_Mapping for å styre SX frekvensomformer via EtherCAT eller 

EthernetIP. Et eget Tips!SX og Nettverksoppsett.pdf er laget for dette 

 

 
 

Flere parameter kan legges inn i strukturen direkte. 

 

 

6.3.8 SX_MappingStd 1.0.0 
Ei funksjonsblokk for å styre en SX-omformer via EtherCAT eller EthernetIP. Standard oppsett for SX er 4 byte inn 

og 4 byte ut. Disse blir koblet til en egen datastruktur for SX. SX01 i eksemplet nedenfor. Ønsker man mer enn disse 

4 byte, se SXMappingAdv nedenfor. 
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Et eget Tips!SX og Nettverksoppsett.pdf er laget for dette   
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6.3.9 SX_MappingAdv 3.2.0 
 

Ei funksjonsblokk for å styre en SX-omformer via EtherCAT eller EthernetIP. Standard oppsett for SX er 4 byte inn 

og 4 byte ut. Disse er angitt øverst i Funksjonsblokka og blir koblet til en egen datastruktur for SX. SXDrive_EIP i 

eksemplet nedenfor. Ønsker man mer enn disse 4 byte, må dette konfigureres både i PDO-mapping og i parametre i 

SX. Et eget Tips!SX og Nettverksoppsett.pdf er laget for dette. Med VarFactor kan man så legge inn faktorer som 

skal multipliseres med råverdiene fra SX slik at variablene i datastrukturen får riktig enhetsverdi. 

 

 
 

Datastrukturen er laget universell slik at man selv kan velge hvilke data som skal legges inn i strukturen.  
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6.3.10 SX_Extended 1.0.0 
Ei funksjonsblokk som kan benyttes til å lese av eller endre en valgfri parameter i SX. 

 

 
Et eget Tips!SX og Nettverksoppsett.pdf er laget for dette 

6.3.11 TSA_MappingStd 1.0.0 
Ei funksjonsblokk for å styre en TSA Softstarter via EtherCAT eller EthernetIP. Standard oppsett for TSA er 4 byte 

inn og 4 byte ut. Disse blir koblet til en egen datastruktur for TSA. MyTSA i eksemplet nedenfor.  

 

 

6.3.12 TSA_Control 1.0.0 
Denne funksjonen brukes sammen med TSA_Mapping for å styre TSA softstarter via EtherCAT eller EthernetIP.  

 

 
Flere parameter kan legges inn i strukturen direkte. 
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6.4 OEN_IOLink 
 

6.4.1 IOLink_E2E 1.1.0 
 

Ei funksjonsblokk som samler IOLink data fra E2E induktiv sensor.  

 

 
 
Sensordata er en datastruktur som inneholder all informasjon fra sensorens Input_Data. I tillegg er noe av dette lagt 

ut på utgangene på blokka for enkel monitorering. Det ligger også symbolvariabler klare i strukturen for data som 

leses inn via funksjonsblokka IOL_ReadObj. 

PortNo er porten på IOLink Masteren. De øvrige inngangene kommer direkte fra IOMap via EtherCAT. 

MonitorOutput er typisk 68 når sensoren ikke er påvirket. 
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6.4.2 IOLink_E3S 1.3.0 
 

Ei funksjonsblokk som samler IOLink data fra E3S fargesensor.  

 

 
 

Sensordata er en datastruktur som inneholder all informasjon fra sensorens Input_Data. I tillegg er noe av dette lagt 

ut på utgangene på blokka for enkel monitorering. Det ligger også symbolvariabler klare i strukturen for data som 

leses inn via funksjonsblokka IOL_ReadObj. 

PortNo er porten på IOLink Masteren. De øvrige inngangene kommer direkte fra IOMap via EtherCAT. 
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6.4.3 IOLink_E3Z 1.0.0 
 

Ei funksjonsblokk som samler IOLink data fra E3Z fotocelle.  

 

 
 
Sensordata er en datastruktur som inneholder all informasjon fra sensorens Input_Data. I tillegg er noe av dette lagt 

ut på utgangene på blokka for enkel monitorering. Det ligger også symbolvariabler klare i strukturen for data som 

leses inn via funksjonsblokka IOL_ReadObj. 

PortNo er porten på IOLink Masteren. De øvrige inngangene kommer direkte fra IOMap via EtherCAT. 
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6.4.4 IOLink_E8FC 1.2.0 (under utvikling) 
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6.4.5 IOLink_GX_ILM08C 1.2.0 
 

Ei funksjonsblokk som samler IOLink portdata fra GX_ILM08C EtherCAT-modul.  

 
GX_ILM08C_Status er en datastruktur som inneholder all informasjon fra alle portene på modulen.  

 

 
 
Inngangene kommer direkte fra IOMap via EtherCAT. 
 
Dette er datastrukturen som er laget for denne funksjonen. 

 

 
 

6.4.6 IOLink_GX_ILM400 1.1.0 
 

Ei funksjonsblokk som samler IOLink portdata fra NX_ILM400.  

 
NX_ILM400_Status er en datastruktur som inneholder all informasjon fra alle portene på modulen.  

 

 
Datastrukturen for ILM400_Status følger samme prinsipp som for GX_ILM08C.  
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6.4.7 IOL_ReadObj 
 

Ei funksjonsblokk i standardbiblioteket for å lese sensordata via IOLink. Utklippet nedenfor viser hvordan det kan 

gjøres med GX_ILM08C som EtherCATnode #5 og E3S tilkoblet port 1 på GX. 
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6.5 OEN_Components 
 

Dette er et Library som krever at OEN_BaseBlocks også er installert. 

 

6.5.1 DevicePort_Setup 1.2.0 og KM_PowerMonitor 1.4.0 
 

https://industrial.omron.no/no/products/km-n2 

 

DevicePort_Setup (i OEN_BaseBlocks) forenkler oppsettet for inngangen på KM_PowerMonitor som er en FB for 

kommunikasjon med Omrons forbruksmåler KM-N2 via ModbusRTU. Blokka leser kontinuerlig data fra KM og 

oppdaterer datastrukturen KM_Unit. Det finnes egne tags i strukturen for å overføre endringer og resette 

akkumulatorer. 

 

 
 
Target kan være en variabel når flere KM er tilkoblet samme Modbusforbindelse og brukes enklest sammen med FB 

Sequencer (i OEN_BaseBlocks) som gjør at bare en FB er aktiv i gangen. Når Target=UnitAddress vil 

funksjonsblokka bli kjørt. 

 

 
 

 
Pass på så utgangen til strømtrafoen er 1A eller 5A hvis du velger å benytte andre typer. 
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6.5.2 S8VK 1.3.0 
 

https://industrial.omron.no/no/products/s8vk-x 

 

En Funksjon for å lese ut data fra et S8VK-X powersupply via Ethernet/IP.  

S8VK_EIP tar seg av rådata som kommer fra S8VK-X.  

S8VK-Status inneholder en mer lesbar og skalert versjon av disse dataene. 

 

 
 

Sett PCen din I Subnet 192.168.250. 

 

Sett en ny IP-adresse (om nødvendig) på S8VK-X med Network Configurator. 

Default er 192.168.250.20. 

 

  
 

 

Lag Globale variabler i Sysmac Studio og rediger disse som vist under: 

 
 

Lag TagSet for EthernetIP: 
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Legg inn riktig Target i forhold til type Powersupply. Her setter du også inn IP-adressen til S8VK-X.

 
 

Koble TagSettet til datapakke 100 som blir sendt fra Target Device S8VK-X. 

 
Data som kan leses fra strukturen:
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6.5.3 K6PM 1.0.0 
 

https://industrial.omron.no/no/products/k6pm-th 

 

En Funksjon for å lese ut data fra K6PM temperaturovervåking via Ethernet/IP. K6PM_Status inneholder blant 

annet data for alle tilkoblede sensorer. 

 

 
 

De 5 Globale variablene i eksemplet er vist nedenfor. Legg merke til at EIP-variablene har NetworkPublish=Input. 

Det er ikke nødvendig å sette opp alle variablene hvis man ikke har komplett sett med sensorer (31stk). 

 

 
 

I EIP Connection Setup lager man Input TagSet med tilhørende Global variabel. 

 
 

Til slutt kobler man TagSets til TargetVariables. Merk innstillingene på Input Assembly og RPI (1000ms). 

 
RPI=Oppdateringsfrekvens. Bør settes til 1000ms eller mer iflg. Manualen H231  
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6.6 OEN_Communication 
 

Her følger en kort beskrivelse av funksjonsblokkene i OEN_Communication rev 1.16. Legg merke til at alle disse 

funksjonene og funksjonsblokkene ligger i egne mapper (Namespace) under \\OEN\. 

 

Funksjonsblokker må ha egne navn når du bruker dem i programmet. Funksjoner skal ikke ha det. Begynn gjerne 

med FB i navnet slik at du skiller dem fra andre variabelnavn. 

 

Se User manual OEN_Communication Lib for detaljert beskrivelse av hver enkelt F/FB. 
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6.7 OEN_RFID 
 

6.7.1 V680S_ReadWrite40 1.0.0 
 

https://industrial.omron.no/no/products/v680-v680s 

 

Ei funksjonsblokk for å lese og skrive data på Omron V680S RFID system via Ethernet/IP. Det er laget egen 

dokumentasjon på hvordan du gjør dette. Se Tips! V680S på EIP mot NJ 
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6.8 OEN_Robot 
 

Dette er et Library som krever at OEN_BaseBlocks og MTCP_NJNX også er installert. 

 

6.8.1 Adept_Robot 1.0.0 
 

En funksjon for å lese/skrive data til/fra en Omron ADEPT Robot via Ethernet/IP. Strukturen ADEPT forenkler 

tilgangen til variablene. Sammen med denne FB må en legge til en egen Task i Ace for å koble sammen dataene på 

riktig måte.  

 

 
 

Deler av strukturen er vist i utklippet nedenfor:

 
 

Her er noen utklipp som beskriver oppsettet for EthernetIP: 
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Liste over nødvendige Task og variablene i Ace. 

 

Se filene Data_exchange.v2, ADEPT EIP Toolbox Mapping.xls og OEN_Toolbox EIP.awp.  
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6.8.2 Anyfeeder_Control 1.0.0 
 

Anyfeeder brukes vanligvis til roboter for å plukke produkter enkeltvis styrt med et kamera. 

 
 

«DevicePort_Setup» kan brukes både på frontmontert og sidemontert CIF-modul. 

SerialBoard_ID (NX1P2) lager du i I/OMap, samme for NX_CIF_Unit_ID (NX1P2/NX102) 

NX_CIF_Port er som oftest 1 ved bruk av NX-CIF. 

Utgangen DevicePort må du koble inn på DevicePort på «Anyfeeder_Control». 

 

Execute og Command til «Anyfeeder_Control» kan du opprette selv eller bruke utgangene fra «AnyfeederCMD» 

nedenfor.  

Repeats og Speed må du også legge til. 

 

Et eget eksempelprogram for dette finner du på vår Sharepoint. 

Se også Matrix-blokkene i OEN_Servo. 

 

6.8.3 AnyfeederCMD 1.0.0 
 

En FB for å forenkle sending av kommandoer til Anyfeeder via Anyfeeder_Control. 

 

 
 

Utgangene fra denne Funksjonen må du koble inn på Anyfeeder_Control. 

 

Litt mer utfyllende info finner du i Tips!Anyfeeder.pdf på Sharepoint. 
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6.8.4 TM_ModbusTCP 2.12.0 
Ei funksjonsblokk for å kommunisere med Omrons TM-Cobot på ModbusTCP. Denne FB er bedre forklart med 

eksempler i den norske guiden Start!TM Cobot. 

 

 
 

På Connected bør man koble utgangen fra funksjonsblokka TCP_Connect. 

Med MessageDelay kan man forsinke hver spørring mot roboten for å redusere trafikken. 

MessageCounter viser hvor mange meldinger som sendes over ModbusTCP.  

LoopTime viser hvor fort det går å gjennomgå alle spørringer. 

I TM_Robot.DataSelect velger man hvilke data man trenger å lese fra Roboten. Dette settes som TRUE 

på .DataSelect-variabler. 

I strukturen sTMRobot finnes også Comm.Stats som teller vellykkede/mislykkede spørringer. 
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Et lite utvalg fra sTMRobot er vist i bildet under
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6.8.5 TM_Control 1.0.1 
Denne blokka kobler du på Running-utgangen på TM_ModbusTCP. Her kan du på en enkel måte starte og stoppe 

roboten. Se Start!TM Cobot for mer informasjon. 

 

 
 

6.8.6 TM_ErrorCodes 1.0.0 
Denne blokka konverterer ErrorCode på TM til en feilmeldingstekst. Fin å bruke mot operatørpanelet. 

 

 

6.8.7 UR_Robot 1.0.0 
 

En funksjon for å lese/skrive data til/fra en UR-Robot via Ethernet/IP. Strukturen UR forenkler tilgangen til 

variablene. 

 
 

Deler av strukturen er vist i utklippet nedenfor: 
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Her er noen utklipp som beskriver oppsettet for EthernetIP: 

 

 
 

 
 

 
 

 
(Du må legge inn UR sin EDS-fil i SysmacStudio for å få denne inn som TargetDevice). 
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6.9 OEN_Servo 
 

6.9.1 G5_Status 1.0.0 
 

Denne funksjonsblokka deler opp G5-servoens Statusword i utganger på blokka slik at det blir enklere å se hva som 

skjer. 

 

 
 

6.9.2 MatrixTeach 1.2.1 og MatrixDecode 1.2.0 
 

Disse blokkene kan brukes til å generere og nummerere posisjoner på et plukkebrett. (Max 30 rader*30 kolonner). 

 
 

Med TeachFirst angis posisjonen til objekt nr 1. 

Med TeachLast angis posisjonen til siste objekt diagonalt ovenfor objekt nummer 1. 

Øvrige posisjoner genereres automatisk basert på denne informasjonen. 

Tabellkoordinatene Col og Row for Objekt kan deretter leses ut med MatrixDecode. 

 

Ut fra eksemplet får vi at: 

Posisjon for servoX kan leses ut av Matrix via Plukkebrett[Col,Row].Pos.X 

Posisjon for servoY kan leses ut av Matrix via Plukkebrett[Col,Row].Pos.Y 
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6.10 MTCP_NXNJ 
 

NX102 har kommunikasjon over ModbusTCP i standardbiblioteket. For de andre CPUene anbefaler vi å se på 

blokkene som er beskrevet under. 

 

Her følger en kort beskrivelse av funksjonsblokkene i MTCP_NJ rev 2.0.1. Disse er laget av Omron Frankrike og er 

nyttige for kommunikasjon på ModbusTCP.  Bruk gjerne programmet Multiway for å teste kommunikasjonen. For 

hver Modbusnode man ønsker å knytte seg til trengs det en Socket. CPUene i Sysmac-serien har 30 Sockets, noe 

som da blir bestemmende for hvor mange noder man kan kommunisere med samtidig. 

 

Nye revisjoner av funksjonsblokkene finner du her: 

 

https://www.support-omron.fr/services/tous_les_contenus/librairies.php 

 

Multiway ligger her: 

 

https://www.support-omron.fr/details/logiciel.php?id=2017-07-28%20-%2015-42-06%20-%202107046460 

 

Etherway ligger her: 

 

https://www.support-omron.fr/details/logiciel.php?id=2017-07-28%20-%2015-34-21%20-%20636541960 

 

Funksjonsblokker må ha egne navn når du bruker dem i programmet. Begynn gjerne med FB i navnet slik at du 

skiller dem fra andre variabelnavn. 
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6.10.1 MTCP_Client_Connect 
 

Denne funksjonsblokka lager en forbindelse til Serveren/Slaven.  

Legg merke til at IP-adressen til Serveren er en String.  

Port 502 er Standard ModbusTCP.  

Du aktiverer oppkoblingen med Connect. 

 

 

 
 

Det er laget egen dokumentasjon på hvordan du gjør dette. Se Attached Files under Project->Library-> Show 

References. 
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6.10.2 MTCP_Client_Fn03 
 

Denne funksjonsblokka leser Holdingregister fra Serveren/Slaven. Bruk alltid Client_Connect først for å etablere 

kontakt med Serveren. 

Bruk samme Socket som du får ut av Client_Connect. 

Velg Serverens Slave nr. 

Velg første Holdingregister du vil lese ifra. 

Velg hvor mange register du vil lese derfra. 

Sett Send_Request når du vil lese. 

 

Utgangen Register er et Array på 128 WORD som vil inneholde data fra valgte Holdingregister.  

 

 
 

Det er laget egen dokumentasjon på hvordan du gjør dette. Se Attached Files under Project->Library-> Show 

References. 

 

 

6.10.3 MTCP_Client_Fn05 
 

Det er laget egen dokumentasjon på hvordan du gjør dette. Se Attached Files under Project->Library-> Show 

References. 

 

6.10.4 MTCP_Client_Fn06 
 

Det er laget egen dokumentasjon på hvordan du gjør dette. Se Attached Files under Project->Library-> Show 

References. 

 

6.10.5 MTCP_Client_Fn10 
 

Det er laget egen dokumentasjon på hvordan du gjør dette. Se Attached Files under Project->Library-> Show 

References. 

 

6.10.6 MTCP_Client_Fn17 
 

Det er laget egen dokumentasjon på hvordan du gjør dette. Se Attached Files under Project->Library-> Show 

References. 
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6.10.7 MTCP_Server 
 

Ei funksjonsblokk som setter NJ som en Server (Slave) på Ethernet/IP-porten på CPUen.  

0-1024 Holding/Input registers og 1025 Coils kan utveksle data med en Modbus Master. 

 

Blokka har støtte for Funksjonskodene 01,02,03,04,05,06 og 10. 

 
 

Responstiden er målt til 6x Execution Time i den Task hvor blokka lagt inn. En bør unngå å legge blokka i Primary 

Task. 

 

Det er laget egen dokumentasjon på hvordan du gjør dette. Se Attached Files under Project->Library-> Show 

References. 

 

6.11 OEN_NJ 
 

6.11.1 NJSDCard_Info 
 

 

FB to get SD data information on NJ: 

 

 

  
 
Valid data for SD up to 4GByte. 
 

 

 

• Total Volume Size, 

• Size in use 

• Free size 
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• Volume name label 

  
 

Inputs: 

 
Execute: Run the FB 
ShowInKb: it shows in KB instead in Bytes. 
 

Outputs: 

 

Done: Finished 

Busy: Reading SD information 

TotalSize: Volume size ( SD card capacity)  

FreeSize: Free memory Size (B) 

InUse: memory in use 

VolumeName: SD volume name 

Error: Error  
 
ErrorID:  
- if it is 16#2801 
 
ErrorIDEX: 
- 1: SD card is deteriorated, SDCard access Error 
- 2: SD card is not ready ( probably not inserted)  
 
- Other than 16#2801 : Check the ErrorIDEx and see meaning at NJ/NX troubleshooting manual 
 

 

Operation Test: 

 
From FB 
 

  
 
from SD card properties 
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6.12 OEN_IAG_Toolbox 
 

Dette er en samling grafiske objekter for bruk I NA-panelet. En IAG kan du også lage selv for eget bruk. 

 

6.12.1 Four Color Lamp 
 

En lampe hvor du selv kan bestemme farge og styre disse med 4 boolske variabler. 

Fargen må angis som en hexadesimal verdi ut fra RGB-kartet. 
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6.12.2 PIDAT 
 

Et grafisk objekt for å parametrere og monitorere en PID funksjonsblokk i CPUen. 

 

 
Datastrukturen sPIDAT for dette objektet finnes i OEN_DataTypes, noe 

som gjør det veldig enkelt å lage koblinger mot NA operatørpanel og 

globale variabler. 

 

 
 

Etter å ha lagt denne IAG-en inn i en Page på NA må vi legge inn en knytning mot CPUen. 

I dette eksemplet har CPUen fått navnet RO: 
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Eksempel i CPU hvor VSDControl er PID-strukturen og VSD er den analoge inngangen AnalogData:

  
 

Legg merke til at vi ikke har lagt variabler inn på OprSetParams og InitSetParams. Det betyr at 

vi bruker Default settings på disse. Setter du en variabel her, må du sørge for å legge inn ønskede 

verdier i hver enkelt parameter. Hvis ikke, blir de stående på 0 og regulatoren din vil ikke 

fungere i det hele tatt. 
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7 Appendix  - NX102 
 

Verd å merke seg før en begynner med NX102. 

 

 
OBS! port2 støtter ikke OPC-UA. 
 

• Batteri er opsjon for å holde liv i klokka ved lengre strømbrudd. 

 

• Port#1 støtter DirectConnection programmering, OPC-UA(:4840), Ethernet/IP (32 EIP Connections) og  

SocketService (f.eks. ModbusTCP eller MQTT. 60 Sockets) 

(Antall EIP TagSets totalt på CPUen er 40 og ikke 64) (Antall TCPSockets totalt er 60 og ikke 120) 

 

• Port#2 støtter programmering via IP-adresse, FINS og Ethernet/IP (32 EIP Connections) og SocketService 

(f.eks. ModbusTCP eller MQTT. 60 Sockets) 

(Antall EIP TagSets totalt på CPUen er 40 og ikke 64) (Antall TCPSockets totalt er 60 og ikke 120) 

 

• Port#3 støtter bare EtherCAT 

 

• SDCard kan benyttes til Program Backup/Restore, datalogging, resepter og firmwareoppdatering. FAT32. 

 

• Alle CPUer forsynes med 24VDC men ingen har utgang for V og G til NX-units (NX-PF0730 anbefales) 

 

• DIPsw for backup og Restore, firmwareupdate, autoread av program og CPUSafeMode 

 

PORT1 PORT2 PORT3 

192.168.250.1 Default 192.168.251.1 Default  

EthernetIP EthernetIP EtherCAT 

DirectConnection Programmering IP-basert Programmering  

Sockets (ModbusTCP/MQTT osv) Sockets (ModbusTCP/MQTT osv)  

Ikke FINS FINS (9600 Default)  

OPC-UA (4840 Default) Ikke OPC-UA  

 

7.1 Gå online 
 

CPUen kan bare tilkobles PCen via Ethernetportene. Det går fint an å koble seg til PLSen med direkte kabel uten å 

endre på IP-adressen til PCen, såkalt DirectConnection. 

 

Direkte kabel: Velg Direct i SysmacStudio uten å endre IP på PC. Bruk Port#1 til dette. 

Via switch: Endre IP-adressen på PCen til samme Subnett som PLSen. Velg ..via hub, Sett inn PLSens IP-adresse 

(Port#1 192.168.250.1 eller Port#2 192.168.251.1) og gå online. 
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7.2 Maks 32 NX lokalt 
 

Man kan ikke ha mer enn 32 NX-Units til høyre for CPUen. Husk at PowerUnits (PC/PD) også teller med.

 
 

Husk at V og G ikke er tilgjengelig fra CPUen. Det vil derfor ofte være behov for å sette på en NX-PF0730 for å 

kunne forsyne utganger, sensorer, IOLink og analogsløyfer. 

7.3 Max 64 noder på EtherCAT 
 

Maksimalt antall EtherCAT-noder er 64, men det kan godt være 64 NX-noder (inntil 400 NX-moduler) eller 64 

frekvensomformere. Merk at modulen GX-JC06 som deler nettverket i flere grener spiser 2 nodeadresser.

 
 

Det går fint an å ha NX-Safety på EtherCAT sammen med NX102. 

 

7.4 Maks 400 desentraliserte NX-Units 
 

Det er også en grense for hvor mange NX-Units en kan ha totalt i EtherCAT-nettverket. 

Husk at SafetyMaster og PowerUnits (PC/PD) også teller med. 

 

 
 

 

7.5 Husk å velge Task og IP-adresse 
 

Husk å legge programmet ditt under en Task før du overfører prosjektet til PLSen. 

 
 

Det kan også være en god ide å legge inn rett IP-adresse på Ethernet/IP-porten nå. 
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7.6 Servo 
 

Alle NX102 kan styre minst 4 servomotorer på EtherCAT. De minste modellene har bare såkalt SingleAxis Position 

Control. Det betyr at en fint kan kjøre vanlig posisjonering, men en kan ikke kjøre synkrone bevegelser og heller 

ikke momentstyrte bevegelser.    

 

 
 

7.7 Omron FINS 
 

NX102 har støtte for FINS-kommunikasjon på Port#2 slik som Send/Recv. Skal man kommunisere med andre 

CPUer brukes gjerne Ethernet/IP. 

 

Mange Scadaprogrammer og operatørpanel (Omron NB) benytter Omron FINS som protokoll. Skal man 

kommunisere med NX102 via Omrons FINS-protokoll må man opprette register i PLSen. Det gjør man i Memory 

Settings. Deretter må man legge disse inn i lista over Globale variabler.  

 

 
 

Det er også viktig å legge inn både IP-adresse og Nettverksnummer i CPUen. Nedenfor ser du et forslag til standard 

oppsett: 

 

 
 

For Ethernet/IP er det tilstrekkelig med IP-adressen. 

7.8 CJ-moduler og nettverk 
 

Det er ikke mulig å bruke CJ1W-moduler på NX102. Det betyr at vi ikke kan ha Devicenet, CAN, Profibus eller 

Profinet på NX102. 
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7.9 Batteri 
 

CJ1W-BAT01 

NX102 tar vare på program og data i FlashMemory. Derfor er det ikke nødvendig med batteri. 

Hvis programmet ditt er avhengig av riktig klokke og dato, bør du montere batteri slik at klokka ikke stopper når 

den interne kondensatoren er ladet ut. Kondensatoren lades ut etter 7-10 dager uten spenning påslått. 
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8 Appendix  - NX1P2 
 

 

NX1P2 har en lillebror NX1P2-9B. Tabellen nedenfor viser egenskapene til denne i forhold til standardutgaven. 

 

 
 

Lillebror har begrensning i forhold til antall individuelle (PTP) servoakser, minne, syklustid og antall EtherCAT-

noder. Ta høyde for dette ved valg av CPU. 

Beskrivelsen videre i dette Appendix er basert på standardutgaven. 

8.1 Gå online 
 

CPUen kan bare tilkobles PCen via Ethernetportene. Det går fint an å koble seg til PLSen med direkte kabel uten å 

endre på IP-adressen til PCen. 

 

Direkte kabel: Velg Direct i SysmacStudio uten å endre IP på PC.  

Via switch: Endre IP-adressen på PCen til samme Subnett som PLSen. Velg ..via hub, Sett inn PLSens IP-adresse 

(192.168.250.1) og gå online. 

 

8.2 Maks 8 NX lokalt 
 

Man kan ikke ha mer enn 8 NX-Units til høyre for CPUen. Husk at PowerUnits (PC/PD) også teller med. 

Det er ikke tillatt å ha de røde NX-Safety modulene lokalt ved CPUen. 

 
 

Husk at V og G ikke er tilgjengelig fra CPUen. Det vil derfor ofte være behov for å sette på en NX-PF0730 for å 

kunne forsyne utganger, sensorer, IOLink og analogsløyfer. 
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8.3 Max 16 noder på EtherCAT 
 

Maksimalt antall EtherCAT-noder er 16, men det kan godt være 16 NX-noder eller 16 frekvensomformere. Merk at 

modulen GX-JC06 som deler nettverket i flere grener spiser 2 nodeadresser.

 
 

Det går fint å ha NX-Safety på EtherCAT sammen med NX1P2. 

 

8.4 Maks 16 desentraliserte NX-Units 
 

Det er også en grense for hvor mange NX-Units en kan ha totalt i EtherCAT-nettverket. 

Husk at SafetyMaster og PowerUnits (PC/PD) også teller med. 

 

 
 

8.5 Husk å velge Task og IP-adresse 
 

Husk å legge programmet ditt under en Task før du overfører prosjektet til PLSen. 

 
 

Det kan også være en god ide å legge inn rett IP-adresse på Ethernet/IP-porten nå. 

 

mailto:support.norway@omron.com


 
Postadresse:  Besøksadresse:  Telefon:   22 65 75 00  Foretaksregisteret: 

Postboks 109, Bryn Ole Deviks vei 6B Support:   23 17 39 40  NO 852 345 632 MVA 

N-0611 Oslo  0611 OSLO       

support.norway@omron.com   193/194 

 

8.6 Servo 
 

Alle NX1P2 kan styre minst 4 servomotorer på EtherCAT. De minste modellene har bare såkalt SingleAxis Position 

Control. Det betyr at en fint kan kjøre vanlig posisjonering, men en kan ikke kjøre synkrone bevegelser og heller 

ikke momentstyrte bevegelser.    

 

 
 

8.7 Omron FINS 
 

NX1P har ikke støtte for FINS-kommunikasjon slik som Send/Recv. Skal man kommunisere med andre CPUer 

brukes EthernetIP eller eventuelt Send()/Recv() i de andre CPUene. NX1P blir da typisk en FINS-server. 

 

Mange Scadaprogrammer og operatørpanel (Omron NB) benytter Omron FINS som protokoll. Skal man 

kommunisere med NX1P2 via Omrons FINS-protokoll må man opprette register i PLSen. Det gjør man i Memory 

Settings. Deretter må man legge disse inn i lista over Globale variabler.  

 

 
 

Det er også viktig å legge inn både IP-adresse og Nettverksnummer i CPUen. Nedenfor ser du et forslag til standard 

oppsett: 

 

 
 

For Ethernet/IP er det tilstrekkelig med IP-adressen. 
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8.8 CJ-moduler og nettverk 
 

Det er ikke mulig å bruke CJ1W-moduler på NX1P2. Det betyr at vi ikke kan ha Devicenet, CAN, Profibus eller 

Profinet på NX1P2. 

 

8.9 Batteri 
 

CJ1W-BAT01 

NX1P2 tar vare på program og data i FlashMemory. Derfor er det ikke nødvendig med batteri. 

Hvis programmet ditt er avhengig av riktig klokke og dato, bør du montere batteri slik at klokka ikke stopper når 

den interne kondensatoren er ladet ut. Kondensatoren lades ut etter 7-10 dager uten spenning påslått. 
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